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Preface

As part of an effort to improve and enhance the performance and capabilities of its product 
lines, EMC periodically releases revisions of its hardware and software. Therefore, some 
functions described in this document may not be supported by all versions of the software or 
hardware currently in use. For the most up-to-date information on product features, refer to 
your product release notes.

If a product does not function properly or does not function as described in this document, 
please contact your EMC representative.

Audience
This guide is written for NetWorker 7.6 Service Pack 2 and Data Domain operating 
system 4.9 and later. Earlier versions should refer to the NetWorker Data Domain 
7.6 SP1 Integration Guide.

This document is part of the NetWorker documentation set, and is intended for use 
by system administrators. It contains planning, practices, and configuration 
information for the use of NetWorker Data Domain devices within an EMC 
NetWorker backup and storage management environment.

Readers of this document should be familiar with the following tasks:

◆ Identify the different hardware and software components that make up the 
NetWorker datazone.

◆ Follow procedures to configure storage management operations.

◆ Follow guidelines to locate problems and implement solutions.

NetWorker product documentation
Documentation related to the use of NetWorker software can be found at the EMC 
Online Support website, https://support.emc.com. Where available, use the 
NetWorker 7.6 SP2 or 7.6 SP3 versions of the following documents:

◆ EMC NetWorker Installation Guide provides instructions for installing or updating 
the NetWorker software for clients, console, and server on all supported 
platforms. 

◆ EMC NetWorker Cluster Installation Guide contains information related to 
installation of the NetWorker software on cluster servers and clients. 

◆ EMC NetWorker Administration Guide describes how to configure and maintain the 
NetWorker software. 

◆ EMC NetWorker Release Notes contain information on new features and changes, 
fixed problems, known limitations, environment, and system requirements for 
the latest NetWorker software release. 
C NetWorker and EMC Data Domain Deduplication Devices Release 7.6 Service Pack 2 and later Integration Guide 9
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◆ EMC NetWorker Licensing Guide provides information about licensing NetWorker 
products and features.

◆ EMC NetWorker License Manager 9th Edition Installation and Administration Guide 
provides installation, setup, and configuration information for the NetWorker 
License Manager product.

◆ EMC NetWorker Error Message Guide provides information on common NetWorker 
error messages. 

◆ EMC NetWorker Command Reference Guide provides reference information for 
NetWorker commands and options. 

◆ EMC NetWorker Avamar Integration Guide provides planning, practices, and 
configuration information for the use of Avamar deduplication nodes within an 
integrated NetWorker environment.

◆ EMC VMware Integration Guide provides planning, practices, and configuration 
information for the use of VMware and the vStorage API for Data Protection 
(VADP) within an integrated NetWorker environment.

◆ EMC NetWorker Management Console Online Help describes how to perform the 
day-to-day administration tasks in the NetWorker Management Console and the 
NetWorker Administration window. 

◆ EMC NetWorker User Online Help describes how to use the NetWorker User 
program, which is the Microsoft Windows client interface for the NetWorker 
server, to back up, recover, archive, and retrieve files over a network. 

Data Domain product documentation
Documentation related to the use of Data Domain systems can be found at the Data 
Domain Support Portal (support account required), https://my.datadomain.com, 
including:

◆ Data Domain Software Release 5.0 Release Notes

◆ Data Domain Administration Guide

◆ Data Domain Command Reference

◆ Data Domain CLI Guide

◆ Data Domain System Hardware Guide

◆ Installation and Setup Guide for each Data Domain system

◆ Data Domain Initial Configuration Guide

NetWorker related documentation
The following documentation resources provide more information about NetWorker 
software:

◆ EMC Information Protection Software Compatibility Guide provides a list of client, 
server, and storage node operating systems supported by the EMC information 
protection software versions.

◆ NetWorker Procedure Generator (NPG) is a downloadable Microsoft Windows 
application with periodic updates available to NetWorker customers and support 
staff. By means of user-selectable prompts, NPG tailors single-focussed 
documents from high-demand information drawn from the NetWorker product 
guides and the latest advice supplied by the experts.

◆ Technical notes and white papers provide in-depth technical reviews of products 
regarding business requirements, applied technologies, and best practices.
EMC NetWorker and EMC Data Domain Deduplication Devices Release 7.6 Service Pack 2 and later Integration Guide10
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These resources are available at https://support.emc.com. You must have a service 
agreement to use the EMC Online support site.

Conventions used in this document
This document uses the following conventions for special notices.

Note: A note presents information that is important, but is not hazard-related.

IMPORTANT

An important notice contains information essential to software or hardware 
operation. 

Typographical conventions
EMC uses the following type style conventions in this document:

Normal Used in running (nonprocedural) text for:
• Names of interface elements (such as names of windows, dialog boxes, 

buttons, fields, and menus)
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL 

statements, keywords, clauses, environment variables, functions, utilities
• URLs, pathnames, filenames, directory names, computer names, links, groups, 

service keys, filesystems, notifications

Bold Used in running (nonprocedural) text for:
• Names of commands, daemons, options, programs, processes, services, 

applications, utilities, kernels, notifications, system calls, man pages

Used in procedures for:
• Names of interface elements (such as names of windows, dialog boxes, 

buttons, fields, and menus)
• What user specifically selects, clicks, presses, or types

Italic Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis (for example a new term)
• Variables

Courier Used for:
• System output, such as an error message or script 
• URLs, complete paths, filenames, prompts, and syntax when shown outside of 

running text 

Courier bold Used for:
• Specific user input (such as commands) 

Courier italic Used in procedures for:
• Variables on command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by the user

[ ] Square brackets enclose optional values
MC NetWorker and EMC Data Domain Deduplication Devices Release 7.6 Service Pack 2 and later Integration Guide 11
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Where to get help
EMC support, product, and licensing information can be obtained as follows.

Product information — For documentation, release notes, software updates, or for 
information about EMC products, licensing, and service, go to the EMC Online 
Support website (registration required) at:

https://support.emc.com

Technical support  — For technical support, go to the EMC Online support site. On 
the Support page, you will see several options, including one for making a service 
request. Note that to open a service request, you must have a valid support 
agreement. Please contact your EMC sales representative for details about obtaining a 
valid support agreement or with questions about your account.

Data Domain  — Data Domain customer service and technical support provides an 
online portal for searches and inquiries related to Data Domain products:

https://my.datadomain.com

A valid Data Domain support account is required to access the resources on the Data 
Domain support site.

Your comments
Your suggestions will help us continue to improve the accuracy, organization, and 
overall quality of the user publications. Please send your opinion of this document to:

BSGdocumentation@emc.com

If you have issues, comments, or questions about specific information or procedures, 
please include the title and, if available, the part number, the revision (for example, 
A01), the page numbers, and any other details that will help us locate the subject that 
you are addressing.

| Vertical bar indicates alternate selections - the bar means “or”

{ } Braces indicate content that you must specify (that is, x or y or z)

... Ellipses indicate nonessential information omitted from the example
EMC NetWorker and EMC Data Domain Deduplication Devices Release 7.6 Service Pack 2 and later Integration Guide12
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Revision history
E-mail your clarifications or suggestions for this document to:
BSGdocumentation@emc.com

The following table lists the revision history of this document.

NetWorker Data Domain integration features
The EMC® NetWorker® release 7.6 Service Pack 2 integration with the EMC Data 
Domain® software offers the following features.

Integrated deduplication backup with DD Boost software
The DD Boost software solution that integrates NetWorker software with logical 
storage devices on Data Domain systems enables backup data to be deduplicated on 
a NetWorker storage node before it is sent for storage on a Data Domain system. This 
feature dramatically reduces the amount of data that is sent and stored on the Data 
Domain system and reduces the bandwidth used by the storage process. 

The DD Boost software enables multiple concurrent storage and recovery operations, 
unlike conventional virtual tape library (VTL), and CIFS or NFS AFTD interfaces on 
Data Domain systems.

Revision Date Description - added or changed sections

07 Jan. 10, 2013 Clarified “Data Domain native replication support” on page 68.
Clarified CDI not used in “Configure a NetWorker Data Domain device” on 
page 58.
Changed book title to: EMC NetWorker and EMC Data Domain Deduplication 
Devices Integration guide.

A06 NOv. 19, 2012 Updates for NetWorker 7.6 SP4, including:
Table 1 on page 15 updated with latest DD OS and DD Boost library versions.
“Recovery support” on page 17 updated for multiple concurrent recovery 
sessions and use of DFA (Client Direct).
“Data Domain Device Type Enabler” on page 18 updated for licensing changes in 
NetWorker 7.6 SP4 and later.
Table 6 on page 91 updated for upgrade options.

A05 Dec. 30, 2011 “Save stream performance” on page 25 (updated)
“Recover stream performance” on page 25 (new)

A04 May 18, 2011 “DD Boost devices on Data Domain systems” on page 24
“Data Domain Archiver system” on page 19
“DD Boost devices on Data Domain Archiver systems” on page 24

A03 May 5, 2011 “NetWorker application modules” on page 21
“Backup fails for older NetWorker application modules” on page 86

A02 May 2, 2011 “Support for client-side deduplication backup and recovery” on page 16
“NetWorker application modules” on page 21
“Dedicated storage node environment” on page 37
“Configure a backup client with the client wizard” on page 63
“Configure a backup client with the property windows” on page 64

A01 April 21, 2011 Initial publication of this document.
EMC NetWorker and EMC Data Domain Deduplication Devices Release 7.6 Service Pack 2 and later Integration Guide14
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DD Boost software consists of the following two components:

◆ The DD Boost library API enables the NetWorker software to communicate with 
the Data Domain system.

◆ The distributed segment processing (DSP) feature enables data deduplication to 
be performed on a NetWorker storage node or other supported host before the 
data is sent to the Data Domain system for storage.

Storage on NetWorker Data Domain devices
Deduplicated data backups are stored on special NetWorker Data Domain 
(DD Boost) storage devices on the Data Domain system that are accessed by the 
NetWorker storage nodes and server:

◆ Each device has read-write and read-only components to enable concurrent read 
and write operations. 

◆ Each device is identified with a single NetWorker storage volume and is created 
as a sub-folder of a Data Domain storage unit (SU) folder. 

◆ By default, each SU handles a Networker datazone and is named after the short 
hostname of the NetWorker server.

◆ For Data Domain 5.0 and later systems it is recommended to avoid more than 14 
active SUs. 

◆ There is no recommended limit to the number of NetWorker Data Domain 
devices that may be created, but for best performance, use fewer devices and 
more backup sessions on each device.

◆ All backup, clone copy, restore, disaster recovery, monitoring, and reporting 
operations for data on these devices are managed by the NetWorker Management 
Console (NMC) software.

DD Boost version and DDOS support 
The maximum number of backup sessions (save streams) enabled for each 
NetWorker Data Domain device has increased to 60 with NetWorker 7.6 SP2 and 
later. The previous release, NetWorker 7.6 SP1, uses DD Boost library 2.2.2, which 
enforces a maximum of 10 sessions on each NetWorker Data Domain device. Due to 
this limit on sessions, some environments might have been configured with a large 
number of NetWorker Data Domain devices.

Table 1 on page 15 provides a compatibility matrix for DD Boost library and DD OS 
versions supported by each NetWorker 7.6 release. 

“Version requirements” on page 17 provides details. 

Table 1 NetWorker DD Boost library and supported DDOS versions

NetWorker version
DD Boost library supported 
versions DDOS supported versions

NetWorker 7.6 SP1 2.2.2 4.8. 4.9

NetWorker 7.6 SP2 2.3.1 4.9, 5.0

NetWorker 7.6 SP3 2.3.1 (initial release); 
2.4 (NetWorker 7.6.3.3)

4.9, 5.0
5.0, 5.1

NetWorker 7.6 SP4 2.4 5.0, 5.1, 5.2
NetWorker Data Domain integration features 15



Introduction
Devices inherited from NetWorker 7.6 SP1
Previously, in NetWorker 7.6 SP1, the NetWorker Data Domain devices were created 
at the level of a Data Domain storage unit (SU). This is unlike NetWorker 7.6 SP2, 
which creates the devices as sub-folders of SU folders:

◆ Old inherited devices are still available for use and appear in the NetWorker 
Administration program’s Devices view but do not appear in the NMC Device 
Configuration Wizard. 

◆ A Data Domain system with more than 99 NetWorker Data Domain device 
folders will fail the upgrade process from DD OS 4.9 to 5.0.

Appendix A, “Upgrading to NetWorker 7.6 SP2 and later,” provides details.

Cloning and remote storage of backups
Backups that are stored on a Data Domain system may be copied to remote storage 
for added protection and efficient disaster recovery. These copies are configured and 
launched by the NMC clone feature and are indexed and retained according to 
NetWorker storage policies.

There are two types of clone operations, both of which require the DD Boost software 
on the storage nodes:

◆ The clone-controlled replication or “optimized clone” feature is used to replicate 
data from a NetWorker Data Domain device to another NetWorker Data Domain 
device at a different location. This option preserves the deduplicated data format 
and minimizes bandwidth usage between the Data Domain systems.

◆ The clone to native format feature is used to clone data from Data Domain storage 
to traditional disk or tape storage. This option reverts the data to its native 
non-deduplicated format, which is required for data to be recoverable from 
storage on a traditional disk or tape system. 

Cloning and staging procedures are also used to migrate the data stored on 
NetWorker Data Domain devices from 7.6 SP1 to 7.6 SP2. Appendix A, “Upgrading to 
NetWorker 7.6 SP2 and later,” provides details.

Support for client-side deduplication backup and recovery
For some types of data, NetWorker Data Domain devices support client direct file 
access (DFA), which enables client-side deduplication backup and recovery. 

Note: The term DFA was changed in later versions of this product to “Client Direct”.

Table 2 on page 17 lists DFA backup and recovery support for different data types.

“Client direct file access (DFA) deduplication environment” on page 38 provides an 
example.

Backup support
The DFA feature enables supported NetWorker clients to deduplicate their backup 
data locally and store it directly on a NetWorker Data Domain device, thereby 
bypassing the NetWorker storage node and reducing network bandwidth usage. 

Because multiple clients with DFA backup support can share a device by using 
multiple sessions, DFA can reduce the number of devices used, thereby reducing the 
impact on the Data Domain system performance and maintenance.
EMC NetWorker and EMC Data Domain Deduplication Devices Release 7.6 Service Pack 2 and later Integration Guide16
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Recovery support
If a supported DFA client has access to its NetWorker Data Domain storage device, it 
will recover data directly from the device, regardless of whether DFA was used for 
the backup. Because DFA bypasses the storage node, performance is improved. If the 
DFA client cannot access the data, then the recovery process reverts to the traditional 
method that uses the storage node. The Data Domain system converts the stored data 
to its original non-deduplicated state for the recovery. 

Table 2 on page 17 lists DFA support requirements.

* All DFA recovery clients require NetWorker 7.6 SP1 or later client software.

The EMC NetWorker Module for Microsoft Applications Administration Guide provides 
details on how to configure an NMM Client resource for Data Domain Boost backups.

Data Domain configuration and monitoring
Configuration, monitoring, and reporting of backup and restore operations on 
NetWorker Data Domain devices is provided by the NMC Internet portal. The NMC 
server is accessible from any supported remote Internet browser.

The NMC Device Configuration Wizard simplifies the configuration of storage 
devices, backup clients, storage pools, volume labeling, and save set cloning.

Features not supported by the integration
The following Data Domain or NetWorker features are not supported by the 
integration: 

◆ Data Domain Retention Lock

◆ NetWorker data compression and encryption are not supported for clients that 
use the integration

Version requirements
The hosts in a NetWorker Data Domain backup and recovery datazone should meet 
the following minimum version requirements:

◆ The NetWorker server must be installed with NetWorker 7.6 SP2 or later software. 
This software includes the DD Boost 2.3.1 library.

◆ The Data Domain operating system (DD OS) must be version 4.9 or later.

Table 2 DFA support with NetWorker 7.6 SP1 and later software

Data type DFA backup DFA recovery*

NMM, specifically:
• Microsoft Exchange 2010
• Microsoft SharePoint 2010
• Microsoft SQL Server 2008 R2

NMM 2.3 with one of the following:
• NW 7.6 SP1 server with supported DD OS
• NW 7.6 SP2 server with supported DD OS
• NW 7.6 SP3 server with supported DD OS
• NW 7.6 SP4 server with supported DD OS
DD OS supported versions are identified in Table 1 
on page 15. 

NMM 2.3
NMDA 1.2

File system NW 8.0
Not supported in earlier versions

Supported
Version requirements 17
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◆ NMC must be release 7.6 SP2 or later.

◆ Any storage node that uses NetWorker Data Domain devices must be running 
NetWorker 7.6 SP2 or later.

◆ NetWorker clients may be earlier releases, although release 7.5 SP3 or 7.6 and later 
is recommended. Clients that use NetWorker application modules with DFA and 
DD Boost should be upgraded to NetWorker 7.6 SP2 or later.

◆ Other NetWorker storage nodes and clients that are not directly managing or 
sending data to the Data Domain system can be earlier releases although release 
7.5 SP 3 or 7.6 and later is recommended.

Appendix A, “Upgrading to NetWorker 7.6 SP2 and later,” provides upgrade details.

License requirements
A fresh installation of a NetWorker release (not an upgrade) enables evaluation of all 
features, including Data Domain features with no enabler (license key) required for 
30 days. You can extend this evaluation period by 15 additional days by typing grace 
as an authorization code before the 30-day expiry period. After expiration, backups 
cannot be performed unless permanent enablers are applied. 

NetWorker licenses
Two types of license keys must be enabled for the NetWorker server to interact with a 
Data Domain or Data Domain Archiver system, the Data Domain Device Type 
Enabler and a Data Domain Device Type Capacity Enabler. Upgrade enablers may be 
available for earlier releases.

The EMC NetWorker Licensing Guide and your EMC sales representative can provide 
licensing details.

Data Domain Device Type Enabler
A minimum of one NetWorker Data Domain Device Type Enabler (also known as 
“DD storage system enabler” or “DD Boost enabler”) is required on the NetWorker 
server. Additional licenses may be required based on the following usage:

◆ Number of NetWorker datazones (NetWorker servers)

◆ Number of Data Domain systems (no additional licenses required in NetWorker 
7.6 SP4 and later)

◆ Number of network identities: Additional license for each network identity (no 
additional licenses required in NetWorker 7.6 SP4 and later)

For example, a NetWorker server will require three enablers to allow it to use 
three NICs on a Data Domain system if each NIC has a separate network identity 
as follows:

• Each NIC has its own IP address and network name.

• Each NIC is used for a device with the Media type attribute set to Data 
Domain. “Configure a NetWorker Data Domain device” on page 58 provides 
details.

• The NICs are not aggregated (by ifgroup).

However, if you use the Data Domain ifgroup command, you can effectively 
configure an aggregated link for the individual NICs, provided they are on the 
EMC NetWorker and EMC Data Domain Deduplication Devices Release 7.6 Service Pack 2 and later Integration Guide18
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same network, so they will all appear (and be addressed) as a single network 
identity and require only a single DD system enabler.

Data Domain Device Type Capacity Enabler
The amount of Data Domain usable storage available in a NetWorker datazone is 
provided by a NetWorker Data Domain Device Type Capacity Enabler (DD capacity 
enabler). There is no restriction on the number of NetWorker Data Domain devices 
that can be created other than the overall device limits for the NetWorker datazone. 

The EMC NetWorker Licensing Guide provides requirements for environments that use 
a NetWorker capacity license. Contact your EMC sales representative for licensing 
details.

Data Domain licenses
The Data Domain or Data Domain Archiver system must be enabled with the 
following licenses:

◆ OPENSTORAGE license (DD Boost license)

◆ REPLICATION license (if clone-controlled replication will be used)

To verify if the licenses are enabled on the Data Domain system, type the license 
show command. For Data Domain versions 4.8.x and 4.9x, the output should read 
OPENSTORAGE, if the DD Boost license is installed, and additionally 
REPLICATION if a Replicator license is installed. “Configure the Data Domain 
system for NetWorker” on page 52 provides details.

For upgrade and other inquires, contact the Data Domain services and support portal 
at https://my.datadomain.com.

Hosts and software
This section describes hosts and software used in the NetWorker backup and 
recovery environment with Data Domain storage systems.

Data Domain storage system
A Data Domain system that runs DD OS 4.9 or later software can store deduplicated 
backup or cloned data on NetWorker DD Boost storage devices that are accessed by 
the NetWorker storage node. For full compatibility with NetWorker software, install 
the latest upgrade of DD OS software.

A Data Domain server can support mixed environments that may include DD Boost 
devices, VTLs, and CIFS or NFS AFTD disk configurations. 

Data Domain Archiver system
This is a specific model of Data Domain storage system that has been designed for the 
management of long-term data retention. NetWorker DD Boost devices may be be 
created on a Data Domain Archiver that runs DD OS 5.0 or later software. The archive 
tier does not require additional capacity licensing. 

A Data Domain Archiver system can support mixed environments that may include 
DD Boost devices and CIFS or NFS AFTD disk configurations.
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NetWorker Management Console server
The NMC server provides a user interface for NetWorker configurations and 
monitoring. The NMC server must run NetWorker 7.6 SP2 or later software and have 
network access to NetWorker storage nodes and Data Domain systems. 

Console client
The NMC server may be accessed and operated from a Console client on a remote 
computer with a supported Internet web browser and Java Runtime Environment 
(JRE) software installed. Multiple users can access the NMC server concurrently from 
different portals. 

The EMC NetWorker Installation Guide provides information on supported web 
browsers and versions of the JRE. 

NetWorker server
NetWorker 7.6 SP2 or later software must be installed on the NetWorker server that 
stores or clones data on Data Domain systems. 

The NetWorker software provides services to back up and recover data for client 
computers within a NetWorker datazone. Deduplicated backup data is stored on a 
Data Domain system by the use of special NetWorker Data Domain devices, which 
are created and managed by the NetWorker software. The NetWorker software also 
provides features to create clone copies of stored deduplicated data.

The EMC NetWorker Release Notes provides details on supported Data Domain 
features.

NetWorker client
A NetWorker client is a supported host whose data requires backup and restore 
services. The NMC server, NetWorker server, and NetWorker storage nodes are all 
NetWorker clients. 

NetWorker client software must be installed and running before NetWorker Data 
Domain devices are configured. Clients may use a supported earlier release of 
NetWorker client software than the NetWorker server or storage node.

The EMC Information Protection Software Compatibility Guide provides information on 
supported releases.

NetWorker storage node
NetWorker 7.6 SP2 or later software must be installed on each storage node that 
stores or clones data on Data Domain systems. All storage nodes within the same 
NetWorker datazone should be of the same release and patch level.

Data that is to be backed up on NetWorker Data Domain devices is deduplicated on a 
NetWorker storage node, with the distributed segment processing feature, before it is 
sent to the Data Domain system for storage. The storage node reviews the data that is 
already stored on the Data Domain system and sends only unique data for storage.
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NetWorker application modules
Deduplication backup and recovery operations are supported for clients with 
NetWorker application modules, such as NMO, NMDB2, NMSQL, NME, NMDA, 
NMM and NMSAP, provided the module data is sent from the module client to a 
connected NetWorker storage node that is enabled with DD Boost software. 

“Dedicated storage node environment” on page 37 provides an example use case 
environment.

“Support for client-side deduplication backup and recovery” on page 16 provides 
details on modules that support DFA backup and recovery.
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About NetWorker Data Domain devices
The NetWorker 7.6 SP2 software enables the integration of NetWorker features with 
Data Domain storage systems that run the DD Boost software. 

DD Boost devices on Data Domain systems
The NetWorker 7.6 SP2 integration environment creates storage unit (SU) folders, 
also known as parent folders, on the Data Domain system. On Data Domain 5.0 and 
later systems, each SU is created as a separate logical partition called an mtree 
(managed tree). These folders contain the NetWorker Data Domain (DD Boost) 
devices. 

The folder structure has the following features and constraints:

◆ By default, the Device Configuration Wizard names the SU (mtree) it creates for 
the devices after the short hostname of the NetWorker server and each SU 
handles a NetWorker datazone.

◆ To facilitate special use cases, SUs (mtrees) that use different names may be 
manually defined in the wizard. Thus multiple mtrees may be created for a single 
NetWorker datazone.

◆ Avoid configuring of more than 14 active SUs or mtrees on a single Data Domain 
system. Up to 99 SUs or mtrees may be defined.

◆ DD Boost devices are created as sub-folders under these SU (mtree) folders. 

◆ Each DD Boost device should be associated with only a single NetWorker storage 
node, although additional DFA clients are permitted. “Client direct file access 
(DFA) deduplication environment” on page 38 provides details.

◆ Each device is identified with a single NetWorker storage volume.

◆ There is no recommended limit on the number of DD Boost devices that may be 
created. However, increasing the number of devices can impact Data Domain 
performance and maintenance.

CAUTION

Data Domain 5.0 or later systems with more than 14 active SU folders for DD Boost 
devices can suffer impaired performance and hang.

DD Boost devices on Data Domain Archiver systems
Data Domain Archiver systems that run DD OS 5.0 or later software support 
NetWorker Data Domain (DD Boost) devices that run with NetWorker 7.6 SP2 
software. DD Boost devices on Data Domain Archiver systems may be treated the 
same as they would be on standard Data Domain systems, with the following 
considerations:

◆ Data on a Data Domain Archiver system is stored in either of two tiers of an mtree 
file system — active and archive:

a. Incoming data is first placed in the active tier of the file system, similar to 
standard Data Domain systems. This tier is used for short-term data storage 
and recovery.

b. This data can subsequently be moved to the archive tier of the file system 
based on data movement policies.
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◆ An mtree’s data movement policy determines when when data will be moved 
from devices on the active tier to devices on the archive tier. These policies and 
movements are internal to the Data Domain Archiver system and are transparent 
to the NetWorker software.

◆ An mtree applies a single data movement policy to all of the devices it serves 
within its corresponding NetWorker datazone, whether they are NetWorker 
AFTD or DD Boost devices.

◆ Alternative data movement policies may be configured for the client data in the 
same datazone by additional mtrees, which may be manually created in the 
Device Configuration Wizard. 

◆ DD OS 5.0 supports up to 14 active and 99 defined mtrees on a Data Domain 
Archiver system. There is no recommended limit on the number of DD Boost 
devices that may be created on the system. 

◆ The DFA option is supported for clients to write directly to DD Boost archive 
devices, provided that the devices are assigned to a NetWorker storage node for 
data indexing purposes. “Client direct file access (DFA) deduplication 
environment” on page 38 provides details.

The Data Domain documentation provides additional details on Data Domain 
Archiver features and use.

Save stream performance
Multiplexing, the use of multiple concurrent backup save streams (sessions), helps to 
reduce the number of active devices required and thereby reduce the impact on Data 
Domain backup performance and maintenance. Optimum backup performance is 
achieved when there are at least eight concurrent save streams from a storage node to 
each DD Boost device. 

Save streams should be balanced among the available DD Boost devices. New save 
streams should attach to devices with the least load. To support this:

◆ The Target sessions value for DD Boost devices is set to 1 as the default value and 
cannot be set to a value greater than 60. 

◆ The Max sessions value has a default value of 10 and cannot be set to a value 
greater than 60.

“Configure a NetWorker Data Domain device” on page 58 provides further details.

The Data Domain Administration Guide provides details on save streams and 
performance.

Recover stream performance
In NetWorker 7.6 SP3 and earlier, the number of recovery streams (sessions) that can 
be read from a DD Boost device is limited to 1. This is regardless of the number of 
recovery sessions that are started or the device settings for Target or Max sessions.

Optimum recovery performance is achieved where multiple devices were used for 
the backup operation, with minimal or no multiplexing. In cases where this was not 
done, cloning operations can be used to move savesets to other DD Boost devices to 
allow parallel recovery from multiple devices. Another option is to clone to 
alternative devices such as AFTDs where multiple concurrent recovery streams are 
possible. 
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Memory and connection requirements
The physical memory requirement for a NetWorker storage node depends on the 
peak usage of its DD Boost devices. 

◆ Each device that takes one save stream requires 64 MB of RAM on the storage 
node. 

◆ Each additional save stream requires 16 MB. 

◆ Thus one save stream requires 64 MB, eight save streams requires 176 MB, 10 save 
streams requires 208 MB.

◆ The maximum of 60 save streams requires 944 MB. 

Allowing for these requirements as well as for other types of devices and services on 
the storage node, a storage node must have at least 8 GB of RAM when hosting DD 
Boost devices. Each device may also use two interface connections, either 1 GbE or 
10 GbE.

“Network connectivity and firewall” on page 30 provides details on network 
bandwidth and connections.

Devices and media pools
Media pools are used to direct client backups or clone copies of backups to specific 
storage devices. A pool that contains the DD Boost devices should not contain any 
other type of storage media and should not contain devices on more than one Data 
Domain system. This ensures that the backup window and deduplication ratio will 
not be impaired. It also ensures that each backup is stored on a single Data Domain 
system, which simplifies recovery and facilitates Data Domain file replication, if 
desired.

Periodically, review and remove unused pools if they are no longer relevant to the 
storage environment.

Devices in mixed environments
A Data Domain system can support mixed NetWorker environments, which may 
consist of NetWorker Data Domain devices, VTLs, and CIFS or NFS AFTD disk 
configurations. Each different storage environment should use a different interface 
connection, either NIC for IP or FC port for SAN data transport. Data stored on these 
other environments may be migrated to NetWorker Data Domain devices through a 
NetWorker clone process.

Note: Currently, the NetWorker Data Domain devices support only an IP network and do not 
support SAN (Fibre Channel) data transport. 

The EMC Data Domain Storage system with EMC NetWorker 7.6.0 and earlier Best 
Practices Planning White Paper provides details on deployments of NetWorker with 
Data Domain in a VTL or CIFS/NFS AFTD environment. 
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Reclaiming expired storage space
When a backup on a Data Domain system reaches its retention expiry date, all its 
references to the data become invalid. However, unlike traditional storage systems, 
space is not immediately freed up on the device because other backups or clients may 
have deduplication references to the same data. 

For example, the deletion of 1 GB of data, even of unique data from a NetWorker 
perspective, does not result in 1 GB of space made immediately available on the Data 
Domain system.

The DD OS filesys show space or df command shows the data that is eligible to be 
deleted from the Data Domain system under the Cleanable GiB column. 

A review of deduplication references and storage space occurs during a periodic 
cleanup operation, which is scheduled by default to run once per week. 

Note: If a NetWorker Data Domain device becomes full during a backup, the backup fails 
immediately. It does not pause or wait for space to become available.

The DD OS filesys clean command describes all the available options for managing 
how the storage space for redundant or expired data (such as expired NetWorker 
save sets) can be reclaimed and recycled.

Removing a NetWorker Data Domain device
Special procedures are required to remove NetWorker Data Domain devices because 
components of deduplicated data can be potentially lost. Plan the creation of the 
devices and their names with care, as though the devices are permanent.

IMPORTANT

Contact Technical Support for assistance to remove a NetWorker Data Domain 
device.

Deletion or renaming of a device by the NetWorker software does not remove or 
rename the corresponding device folders or their parent folders on the Data Domain 
system.

Note: If you need to remove a device from the NetWorker software, both the read-write and 
read-only components of the device must be unmounted or an error results. To toggle the 
display of these components, in the NetWorker Administration application Devices view, select 
View > Display read-only devices and volumes.

“Deactivating a device” on page 66 provides additional details.

Deduplication ratio and efficiency
Deduplication efficiency is typically measured by the deduplication ratio. This ratio 
represents the reduction in storage space that results from the data 
deduplication/compression technology. Ratios of 20:1 are considered to be broadly 
achievable and reductions of even 5:1 are extremely valuable. 

A number of factors can contribute to the deduplication ratio, including retention 
periods, the type of data being backed up, change rate, the frequency of full backups, 
and the use of encryption and compression. 
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For optimal use of storage space, consider the following factors along with the 
periodic clearing of expired storage space and the removal of unused target pools.

Data types
Some types of user data such as text documents, slide presentations, spreadsheets, 
most database types, source code, and e-mail are known to contain redundant data 
and are good deduplication candidates.

Some other types of data such as audio, video, and scanned images already consist of 
compressed data. Typically, the first full deduplication backup of these data types 
yields low reductions, but subsequent backups will typically produce high 
deduplication ratios if the data has a low change rate. 

Change rate
Data that does not change much between backups (low change rate) produces high 
deduplication ratios and is a good candidate for deduplication. Data that has already 
been stored will not be stored again.

When a completely new save set is deduplicated, the number of unique blocks within 
it can vary widely depending on the data type, and often there is little that can be 
deduplicated. Yet because the Data Domain system compresses the data blocks, there 
is typically a 2:1 to 3:1 (50–75 percent) data reduction. 

The storage savings begin to increase significantly with each subsequent backup of 
the save set because only those data blocks that are unique to each backup need to be 
written to disk. In conventional business operations, the data change rate is typically 
low and unique data may represent only 1–2 percent of the data present in each 
additional backup set. The remainder of the backup is deduplicated against what is 
already stored on the system.

Retention period
The deduplication ratio increases with longer data retention periods. The longer the 
stored save sets are retained, the greater the chances that identical data already exists 
in storage that can be used to deduplicate each subsequent backup, and the greater 
the efficiency of the storage usage. 

Frequency of full backups
Frequent full backups result in high deduplication ratios, but also increased data 
processing on the NetWorker storage node. For example, compare deduplication 
backups performed on a daily full basis with those performed on a weekly full with 
daily incremental basis. Both of these schedules require essentially the same amount 
of storage space and the same network bandwidth between the storage node and the 
Data Domain system because the storage node sends only unique data to storage, 
even for full backups.

A daily full backup schedule, however, sends a greater amount of data from the client 
to the storage node for processing than the weekly full with daily incremental 
schedule.
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Host naming guidelines
The network environment has an impact on hostname resolution methods and you 
should follow the manufacturer recommendations. Use the local hosts file to help 
diagnose and resolve naming issues. You can use the net hosts add command on the 
Data Domain system to add hosts to the /etc/hosts file.

The following guidelines are offered to help you create consistent, easily identifiable 
hostnames that facilitate configuration, reporting, and troubleshooting in the 
NetWorker Data Domain environment:

◆ Create names that are unique across all NetWorker datazones. They should 
identify the network role, such as administration, backup, cloning, or production, 
with possibly a location or server name.

◆ Use a single hostname associated with each NIC or IP interface within the same 
NetWorker datazone. Each new hostname or IP address used by NetWorker will 
require its own enabler.

◆ Include source and target abbreviations in names to quickly identify whether 
network connections are correct. For example, add an abbreviation of the storage 
node hostname in the Data Domain name and an abbreviation of the Data 
Domain hostname in the storage node name. Ensure that these names are 
included in the Data Domain /etc/hosts file.

◆ Specify all aliases, such as long and short names, IP address, and so on for the 
NetWorker server and storage nodes in their respective Client resources (Globals 
1 of 2 tab).

◆ Ensure that all hostnames in the network can be consistently resolved from 
multiple locations in both directions. For example: shortname to IP, longname to 
IP, IP to shortname, IP to longname.

◆ In general, use short, easy to identify, descriptive names instead of IP addresses or 
fully qualified name strings for devices and storage nodes. Long names might not 
fit into some views. Examples of a long and short name:

NWDD365-1.burloak.lab.mycorp.com:/NWDZ_Dr1
NWDD365-1:/NWDZ_Dr1

◆ Use standard alphanumeric characters, including “-” and “_” with no spaces or 
special characters, except that pool names may not use underscores “_”.

◆ Use fixed formats (text field length and case) and include leading 0s in numbers, 
with a maximum of 50 characters.

◆ Avoid the use of dates in names where the dates might change or become 
meaningless in the future.

IP addresses
Avoid IP addresses because numbers are more difficult to identify and troubleshoot 
than descriptive names. 

However, there are exceptions: 

◆ The Data Domain system requires IP addresses to be used to interface with an 
ifgroup for Advanced Load Balancing and Link Failover features. 
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◆ For clone-controlled replications, the hosts file on the source Data Domain system 
should list the IP address of the target Data Domain system. Otherwise, the 
clone-controlled replication will use the same network that is used to access the 
source and target systems for backup and restore operations.

The Data Domain documentation provides details. 

Examples
The following are some example name formats.

NetWorker Data Domain devices
Format: DD-DDsystem name-Device00-99
For example: DD-Tenendo-Device01

Folders on Data Domain system
NetWorker Data Domain device names should refer to the NetWorker storage node 
and indicate whether they are for backup (BACK) or clone (CLON) operation.

Format: storage node_BACK or CLON_DD00-99
For example: DZBurl_BACK_DD01

Volume labels for Data Domain
Format: DD-MEDIA or 5-letter descriptor-000-999
For example: DD-MEDIA-001

Network connectivity and firewall
Because NetWorker Data Domain devices are network-based, supported on Ethernet 
IP networks, consideration should be given to hostname resolution, connectivity and 
capacity, NFS access, and firewall requirements.

The network hostname resolution method depends on your environment and 
manufacturer recommendations. “Host naming guidelines” on page 29 provides 
details.

Network connectivity and capacity
The recommended minimum network connectivity to the Data Domain system is to 
use two 1 GbE network links: one of which is dedicated to administration and the 
other to data backup. Network connections and types can improve on this depending 
on the Data Domain system model.

You can maximize throughput of the Data Domain system by using multiple 
connections or high bandwidth connections. For example, you can use multiple 1 
GbE connections for dedicated storage nodes and storage devices. 10 GbE 
connections are also available and these can be used instead of, or in addition to, 1 
GbE interfaces.

In environments where 10 GbE connectivity is not available or cost prohibitive, two 
alternatives are available:

◆ Use a dedicated 1 GbE connection from a storage node directly to the Data 
Domain system. This provides a private, high-bandwidth data connection and 
avoids the latency and complexity of a shared Ethernet connection. However, a 
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separate traditional Ethernet connection is also required for administration and 
NMC access.

◆ Use two or more NICs on the Data Domain system with 1 GbE connections 
aggregated together by using the Data Domain ifgroup command. This will 
provide increased capacity and can offer some resiliency. The Data Domain 
system provides automatic Advanced Load Balancing and Link Failover for NIC 
connections.

Firewall requirements
Regardless of the network connections used, communication through a firewall 
requires the use of specific ports and protocols for backup, monitoring, and 
replication across sites. Ensure that the following firewall ports are open between the 
Data Domain, NetWorker, and NMC servers:

◆ TCP 111 (NFS portmapper)

◆ TCP 161 (for NMC server to query for alerts and statistics)

◆ TCP 162 (SNMPTRAP for NMC server to monitor status and events)

◆ TCP 2049 (NFS)

◆ TCP 2051 (Replication, if clone-controlled replication is used, Data Domain to 
Data Domain systems)

◆ TCP xxxx (select a random port for NFS mountd, 2052 is the default)
On the Data Domain system, type the following command from SE mode:

# nfs set mountd-port xxxx

Restart the Data Domain system.

The Data Domain system provides functionality to review your network 
configuration and capabilities as well as SSH Telnet to help diagnose issues.

Example backup environments
This section provides some examples of how the NetWorker Data Domain integration 
may be deployed in backup environments. The use of two interfaces, 1 GbE for 
administration and 10 GbE for data, is recommended, as shown in the examples:

◆ “Disaster recovery environment” on page 31

◆ “Cascaded replication environment” on page 33

◆ “Shared datazones environment” on page 35

◆ “Dedicated storage node environment” on page 37

◆ “Client direct file access (DFA) deduplication environment” on page 38

Disaster recovery environment
An example of a disaster recovery (DR) environment would be to use 
clone-controlled replication to copy individual save sets or complete volumes from a 
primary Data Domain storage system to a secondary Data Domain system at a 
geographically distant location. Each cloned replication (optimized clone) is a 
complete and independent copy of the source deduplicated data that is managed by 
NetWorker policies. For added protection, some or all of the stored data may be 
further cloned from the secondary system to tape storage.
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Both the primary and secondary Data Domain systems must be configured, enabled, 
and managed within a single datazone. There may be either a single or separate 
storage nodes for local and remote operations within the datazone. Target devices 
must be properly configured on the secondary Data Domain system. 

Note: Clone-controlled replication across datazones or to Data Domain devices that are not 
managed by NetWorker are not supported.

Figure 1 on page 33 illustrates an example of a disaster recovery environment. Two 
Data Domain Storage System Enablers are required on the NetWorker server, one for 
the primary and one for the remote secondary Data Domain systems:

1. The NetWorker server initiates the backup of client groups within its datazone.

2. Two storage nodes in the datazone write the backup data to media pools, which 
target specific NetWorker Data Domain storage devices on the primary system. 

3. The storage nodes communicate with the primary Data Domain system and store 
deduplicated backup data on the system’s devices over dedicated 10 GbE 
network connections. 

An ifgroup software configuration of NICs on the Data Domain system enables 
the two storage nodes to share the same Data Domain network identity and use a 
single Data Domain Storage System Enabler.

“Data Domain Device Type Enabler” on page 18 provides details on the DD 
system enabler and ifgroup configuration. “Network connectivity and firewall” 
on page 30 provides suggestions on network connections.

4. Clone-controlled replication is used to store optimized clone copies of backups 
from the primary Data Domain system over a network to a geographically distant 
secondary Data Domain system for the purpose of disaster recovery. 

5. As a further option, a NetWorker storage node, attached to the secondary Data 
Domain system, is then able to create an additional NetWorker clone copy of the 
data for one of the backup groups and stores it on traditional disk or tape. The 
data in this copy is reverted to its native non-deduplicated format, which is 
necessary for storage on traditional disk or tape.
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Figure 1 Clone-controlled replication for disaster recovery

Cascaded replication environment
A variation of the disaster recovery environment is the cascade replication 
environment. Once a deduplicated backup has successfully completed, it may be 
used to create multiple clone copies in other locations, either simultaneously from the 
original deduplicated backup or in sequence from clone-controlled replications of the 
original. Each clone replication is a complete and independent copy of the source 
backup, complete with NetWorker policies. There is no limit to the number of clone 
copies that can be made, provided that the source save set used for each clone has 
successfully completed.

As with the previous example, each Data Domain system in the environment must be 
configured, enabled, and managed within the same single NetWorker datazone. 
Target devices must be properly configured on the Data Domain systems that receive 
the clone copies. 

Figure 2 on page 35 illustrates an example of a cascaded replication environment 
with three separate Data Domain systems at three different sites. Three Data Domain 
Storage System Enablers are required on the NetWorker server, one for each Data 
Domain system:

◆ The first site is the primary backup location and is the production site.

◆ The second site is a local site with good communication links to the production 
site, typically within the same geographic location or country. 
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◆ The third site is a disaster recovery (DR) site located at a geographically distant 
location where the communication links would be limited or subject to significant 
latency and bandwidth restrictions. This might be in a different country or 250 
kilometers (150 miles) or more distant from either of the other two sites.

This example environment operates as follows:

1. The NetWorker server initiates the backup of production site client groups within 
its datazone.

2. The production site storage node assigns the backup data to media pools, which 
target specific NetWorker Data Domain storage devices on the primary Data 
Domain system. 

3. The storage node communicates with the primary Data Domain system and 
stores deduplicated backup data on the system’s devices over dedicated 10 GbE 
network connections. 

4. Once the backup successfully completes, clone-controlled replication is used to 
store optimized clone copies of the backups on the primary Data Domain system 
over a network to Data Domain systems at other locations. These clone copies 
may be created by either a sequential or concurrent method:

• In the sequential method, only one clone operation is performed at a time in 
sequence. This method allows the production system to continue to function 
without the need to create additional clones for a distant site.

For example, the original backup on the primary Data Domain system is used 
to create an optimized clone copy on a local secondary Data Domain system. 
Once this has been successfully completed, this copy is used to create an 
additional optimized clone copy on the geographically distant Data Domain 
system. 

Figure 2 on page 35 illustrates data paths 1a and 1b for this method.

• In the concurrent method, it may be possible to perform the clone operations 
simultaneously. This method impacts the production system and requires 
more replication bandwidth. 

Note: The performance required for the concurrent method depends on many factors 
and would need to be validated by testing at the individual sites.

For example, the original backup on the primary Data Domain system is used 
as the source to create simultaneous clones on two target Data Domain 
systems. 

Figure 2 on page 35 illustrates data paths 2a and 2b for this method. 
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Figure 2 Clone-controlled replication cascaded to multiple Data Domain systems

Shared datazones environment
Backups from two datazones may be stored on a single Data Domain system. In this 
environment, the two datazones might use the same high-bandwidth network to 
reduce the number of network identities and Data Domain Storage System Enablers 
required. 

Consideration must be given to dividing the stream counts and memory resources to 
manage the two datazones as separate entities and not allow one datazone to impact 
the performance of the other datazone. The total number of streams and devices 
cannot exceed the total capacity of the Data Domain. 

Figure 3 on page 36 illustrates an example of a dedicated 10 GbE network connection 
that is shared by three storage nodes in two datazones. Two storage nodes belong to 
the DZ-A datazone and one storage node belongs to the DZ-B datazone. In this 
environment, the NetWorker server requires two Data Domain Storage System 
Enablers, one for each datazone: 

1. The two NetWorker servers initiate backups of client groups within their 
respective datazones.

2. The three storage nodes write the backup data to specific pools, which are 
targeted to storage devices on the Data Domain system. 
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Note: A NetWorker Data Domain device cannot be shared across datazones.

“DD Boost devices on Data Domain systems” on page 24 provides details on save 
stream usage and memory requirements. “Data Domain Device Type Enabler” on 
page 18 provides details on Data Domain system enablers:

3. The storage nodes store the deduplicated backup data on the NetWorker Data 
Domain devices over a shared 10 GbE connection. 

“Network connectivity and firewall” on page 30 describes network connections.

4. Additional backup to tape storage may be made either directly from a storage 
node or by a NetWorker clone operation from the Data Domain system. 

Figure 3 Data Domain server shared across two NetWorker datazones
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Dedicated storage node environment
Deduplication backups are supported by high-volume individual clients that each 
have a dedicated storage node. For example, a dedicated storage node may be 
deployed on a client that runs NetWorker Module for Database Applications 
(NMDA). Other NetWorker application modules are also supported in this 
configuration with the exception of NMM 2.2 SP1 or earlier, which do not support 
dedicated storage node operation. This environment may coexist with client groups 
that use shared NetWorker storage nodes in the same datazone. 

Figure 4 on page 38 illustrates a mixed environment of shared and dedicated storage 
nodes. Because of the additional network identity required for the dedicated 10 GbE 
connection for one of the storage nodes, two Data Domain Storage System Enablers 
are required on the NetWorker server:

1. The NetWorker server initiates backups of the various regular client groups as 
well as the module clients on the dedicated storage nodes.

2. The storage nodes write the backup data to specific pools, which are targeted to 
storage devices on the Data Domain system. 

“DD Boost devices on Data Domain systems” on page 24 provides details on save 
stream usage and memory requirements.

3. The storage nodes store the deduplicated backup data on the NetWorker Data 
Domain devices. 

An ifgroup software configuration of 1 GbE NICs on the Data Domain system 
allows greater throughput from multiple storage nodes and the use of a single 
Data Domain Storage System Enabler on the NetWorker server for that network 
identity.

“Data Domain Device Type Enabler” on page 18 provides details on the DD 
system enabler and ifgroup configuration. “Network connectivity and firewall” 
on page 30 provides suggestions on network connections.

4. A heavy usage storage node uses an additional dedicated 10 GbE direct 
connection, which requires an additional Data Domain Storage System Enabler 
on the NetWorker server. 

The EMC Information Protection Software Compatibility Guide provides information on 
NetWorker Application modules compatible with Data Domain systems.
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Figure 4 Single datazone with dedicated storage nodes and one high bandwidth link
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◆ DFA deduplication enables a NetWorker Data Domain device to be shared among 
multiple hosts. Multiple sessions on a device improves performance without the 
need to create multiple devices, which can impair performance.

Figure 5 on page 39 shows an example environment where DFA with DSP is used to 
send deduplicated backup data directly to a NetWorker Data Domain device. The 
same device can also be used by non-DFA clients that use the storage node for 
deduplication backup. 

“Support for client-side deduplication backup and recovery” on page 16 provides 
details on supported NetWorker application modules and other data types.

Figure 5 Client direct file access (DFA) deduplication environment
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Data Redirection and Migration
Redirecting backups to the new devices
Following the upgrade to NetWorker 7.6 SP2 or later, you can redirect the backups of 
existing NetWorker clients to begin using the new NetWorker Data Domain devices. 

Clients are members of backup groups, which use pools to associate the backups with 
storage devices. If you redirect the backups at the pool level, as described in this 
procedure, then minimal effort is required to configure the redirection.

Begin your new redirected backups with a full backup. This avoids a dependency on 
the last full backup stored with the legacy storage environment and the potential 
need to restore from two different environments. Begin with a full backup by either:

◆ Configure the redirection at a time when the next scheduled backup will be a full 
backup. 

◆ Configure the redirection and change the backup schedule to accommodate an 
initial full backup.

Redirect backups to NetWorker Data Domain devices
Plan and perform your redirection operation carefully. Read through the following 
overview procedure completely before you begin. 

Note: Appendix A, “Upgrading to NetWorker 7.6 SP2 and later,” provides information on 
redirecting backups from existing NetWorker Data Domain devices.

To redirect existing scheduled backups to begin using storage on NetWorker Data 
Domain devices:

1. Ensure that the required network connection, hostname resolutions, and licenses 
are available and ready to use. The following sections provide details:

• “License requirements” on page 18

• “Host naming guidelines” on page 29

• “Network connectivity and firewall” on page 30

2. Ensure that the Data Domain system is properly configured. “Configuring Data 
Domain for NetWorker” on page 52 provides details.

3. If you are planning to migrate your existing save sets to the new NetWorker Data 
Domain devices, it is best to migrate before the redirected backups are scheduled 
to begin. Migration will “seed” the Data Domain system and help to reduce the 
bandwidth requirements for future backups. “Migrating legacy save sets to the 
new devices” on page 44 provides further details.

4. If you are upgrading from a NetWorker 7.6 or earlier server on a Microsoft 
Windows system, which used an existing CIFS AFTD on a Data Domain server, 
remove the local administrator account (created to match the Data Domain 
system user account) from the NetWorker Remote Exec Service:

a. Open Control Panel > Administrative Tools > Services.

b. Right-click NetWorker Remote Exec Service and select Properties.

c. On the Log On tab, select This Account, and click Browse.

d. Type the local administrator username that was created to match the Data 
Domain system user account and click OK.

e. Type the password for the account, and click OK.
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f. Right-click the NetWorker Remote Exec Service and click Stop. 

Note: This also stops the NetWorker Backup and Recovery Service and the EMC GST 
service.

g. Right-click the NetWorker Backup and Recovery Service and click Start. This 
also starts the NetWorker Remote Exec Service.

h. If the NetWorker server is also the NMC server, right-click the EMC GST 
Service and click Start.

5. Run the NMC Device Configuration Wizard. The following tasks are specific to 
NetWorker Data Domain devices:

a. Select or create NetWorker Data Domain devices on the Data Domain system 
where the backup save sets will be stored.

b. Select or create a Pool resource that will target the save sets to the devices.

Note: The wizard enforces that a NetWorker Media Pool created for the Data Domain 
system uses only NetWorker Data Domain devices. This can be verified in the NMC 
property windows (Media Pool, Selection Criteria tab) for Target Device > Devices. 
The wizard also sets Target Media > Media type required to Data Domain.

c. Select or create a NetWorker storage node on which to label and mount the 
new devices.

d. Complete the wizard.

“Creating a NetWorker Data Domain device with the wizard” on page 55 
provides details.

6. In the NMC NetWorker Administration window:

a. In the Media view, open the pool created or modified in step 5.

b. In the Data Source attribute, ensure that the groups selected for this pool are 
intended for NetWorker Data Domain devices.

c. Ensure that these backup groups are removed from their legacy pools.

“Create pools to target NetWorker Data Domain devices” on page 61 provides 
details.

Note: Existing individual NetWorker Client resources should not require any changes to 
their settings, including the Data Domain backup attribute. The redirection is more 
efficiently configured in the Pool resource.

7. Test the backup environment to ensure that the new configuration operates 
correctly and existing backups that should be unaffected continue to run as 
expected. For backups to new devices, the test should also include a restore from 
those devices.

8. Start your redirection with a full backup to the new devices. This avoids a 
dependency on the last full backup stored with the legacy storage environment 
and the potential need to restore from two different environments. 

9. Monitor backup performance and adjust the backup schedule to optimize the 
configuration for maximum throughput or additional clients. “Monitoring 
NetWorker Data Domain devices” on page 78 provides details.
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Migrating legacy save sets to the new devices
When you redirect client backups to the NetWorker Data Domain devices, you will be 
left with existing save sets that are stored on the legacy devices or filesystems. The 
legacy stored data may either be retained until expiry or migrated to the new devices.

Whether to retain or migrate your legacy data is a judgment that depends on 
requirements that will differ between sites, clients, and backup types. For example, in 
some cases, you may choose to retain most of your legacy data and migrate only the 
backups of sensitive or high-priority clients or backup types. The following points 
provide some considerations for each of these options:

◆ Retain existing save sets on the legacy storage system until they expire:

• Easiest way to make the transition; no migration is necessary. 

• The legacy storage must be maintained for the life of the legacy data.

• If data needs to be restored, it would need be restored from either the legacy 
environment or the new devices, depending on when it was stored.

• Cloning, storage, and recovery features would be different between the legacy 
and new data.

◆ Migrate existing save sets to the new NetWorker Data Domain devices:

• Frees up the legacy storage system for removal or use by other clients. 

• Allows the new devices to be “seeded” with legacy client data. This ensures 
that subsequent client backups will be deduplicated against the legacy data, 
which can significantly reduce the bandwidth and time required for the first 
regular backup window.

• Offers more flexible storage features with regard to cloning and multiple 
concurrent storage and recovery operations. 

• Maintains NetWorker browse and retention policies and ensures that all save 
sets are managed by the NetWorker software.

Migration versus native Data Domain replication
Do not use the native Data Domain replication feature to migrate data from one Data 
Domain system to another. The NetWorker software will not be able to track, manage, 
or recover legacy save sets that are replicated in this manner. 

An exception is where “seeding” a new system may be used. For example, native 
Data Domain replication can be performed over a local connection to quickly and 
easily seed a new target Data Domain system, which would then be physically 
shipped to a distant location. Although NetWorker cannot immediately recover the 
seeded data, it will reduce the otherwise heavy bandwidth required either for a data 
migration by a NetWorker clone operation, or if no migration, for the initial full 
backups to the target system. This method can be especially effective if the remote 
location has limited network bandwidth.

Migration methods
Data migration is essentially a one-time NetWorker clone operation that is tailored to 
the different device types and time scales. The migration can include all the data or be 
limited to data selected from a specific time frame or backup type, such as weekly full 
backups.
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The details of the migration procedure depend on the method to be used and the 
granularity of the data to be migrated:

◆ A NetWorker scheduled clone operation. “Migration scenarios” on page 46 
provides details.

◆ A NetWorker nsrclone script to be run from a command line. The EMC NetWorker 
Administration Guide provides details. 

◆ A NetWorker staging (data moving) operation. The EMC NetWorker 
Administration Guide provides details.

Migrating legacy save sets to NetWorker Data Domain devices
After you have chosen the migration scenario, migrate your existing save sets to 
NetWorker Data Domain devices. Part of this procedure requires the creation of a 
special clone pool and a NetWorker scheduled clone operation:

1. Choose your migration scenario. “Migration scenarios” on page 46 provides 
details.

2. Plan your migration schedule to ensure that sufficient NetWorker Data Domain 
devices and bandwidth are available and the impact to the regular backup 
window is minimized.

Migration should be performed before NetWorker client backups are scheduled to 
begin by using the new devices. Migration will seed the Data Domain system and 
help to reduce the bandwidth requirements for future backups.

Note: When existing deduplicated VTL or CIFS/NFS AFTD save sets are migrated, the 
save sets are first reverted to their native non-deduplicated format, which the storage node 
reads and stores in deduplicated format on the new NetWorker Data Domain devices. This 
reversion process occurs for both Data Domain and non-Data Domain storage.

3. Create a clone pool to target NetWorker Data Domain devices for the migration:

• In the Data Source attribute, select groups for the migration. 

Typically, you will migrate the same groups that you selected for the 
redirection of backups. “Redirect backups to NetWorker Data Domain 
devices” on page 42 provides details.

• In the Target Devices attribute, select the NetWorker Data Domain devices 
where the migrated data will be stored.

“Create pools to target NetWorker Data Domain devices” on page 61 provides 
details.

4. Configure a NetWorker scheduled clone operation with the Write Clone Data to 
Pool attribute selected for your clone pool.

“Scheduling a clone operation” on page 72 provides details on the scheduled 
clone option.

5. Allow the clone operation to proceed, either according to its schedule or by 
manual start. 

“Starting a scheduled clone operation manually on demand” on page 75 provides 
details.
Migrating legacy save sets to NetWorker Data Domain devices 45



Data Redirection and Migration
6. After the clone operation completes, verify the cloned data on the target devices.

Chapter 6, “Monitoring, Reporting, and Troubleshooting,” provides details on the 
verification of NetWorker operations.

7. Once the cloned save sets have been verified, if desired, you may remove the 
original save sets. 

8. If the original save sets are removed, you may remove old unused devices and 
pools to ensure that they are not mistakenly used or cause confusion. A pool may 
not be deleted until all volumes that belong to that pool are also deleted or 
relabelled into other pools.

9. Monitor the Data Domain system to ensure that adequate storage capacity is 
available. Monitor a complete backup cycle of all clients, including save set 
expirations. 

Chapter 6, “Monitoring, Reporting, and Troubleshooting,” provides details.

Migration scenarios
This section offers some typical scenarios to help you migrate existing backup data 
from legacy devices or filesystems to NetWorker Data Domain devices. The best 
scenario for you will depend on the configuration of your current storage 
environment and the capacities and bandwidth available. 

Some example migration scenarios are as follows:

◆ “Migrating to a new DD system from traditional tape or disk storage” on page 46:

• “Migrate to new devices on a different storage node” on page 47

• “Migrate to new devices on the same storage node” on page 47

◆ “Migrating to the existing DD system from non-integrated storage” on page 48:

• “Migrate to a new devices on a different storage node” on page 49

• “Migrate to new devices on the same storage node” on page 49

Migrating to a new DD system from traditional tape or disk storage
In these first two migration scenarios, you have added a new Data Domain system to 
your existing NetWorker storage environment. You want to migrate and deduplicate 
your legacy data, which is currently stored on traditional tape or disk, to the new 
system. The reason for this migration might be that the old storage system is due to 
be removed or you wish to free up space on the old system for other clients. 

How many clients you migrate depends on how much data you want to move and 
the purpose of the migration, whether for client recovery or simply for seeding for 
future backups. Because the new Data Domain system contains no data, at least some 
minimal seeding is desirable. If the data for one client is migrated to seed the Data 
Domain system and the same data is likely to be found on other clients, then 
migrating the data for the additional clients might have diminishing seed value.

Two migration scenarios of this type are presented. In the first case, the NetWorker 
Data Domain devices are created on a new storage node. In the second case, the 
devices are created on the existing storage node.
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Migrate to new devices on a different storage node
Figure 6 on page 47 illustrates a scenario where legacy backups of the client OLIVE, 
which were stored by the storage node CASSIE on traditional tape or disk, will be 
migrated to a different storage node ERIC for storage on the Data Domain system. 

In this scenario, the IP network is used to transfer the data from the original storage 
node CASSIE to the new storage node ERIC. The time required for the transfer will 
depend on the capacity and bandwidth available on the IP network, irrespective of 
the fact that the tape library is on a SAN. If this same IP network is used for backup 
and restore operations, then additional effort and time will be required to ensure that 
the data transfer does not impact the regular backup operations. 

Figure 6 Migration from traditional storage to NW-DD devices on a different storage node
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◆ Although the same storage node will be used for the same backup clients, 
changes to pools and device allocation are still required. This could add confusion 
and be more prone to configuration errors.

For smaller sites, it may be a desirable to avoid network restrictions by migrating to 
new devices on the same storage node. This could also be an option for larger sites 
where multiple storage nodes are to be reused or reconfigured to share one or more 
Data Domain system. A storage node could be configured for data migration to seed 
the Data Domain system as an interim step.

Figure 7 Migration from traditional storage to NW-DD devices on the same storage node
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Migrate to a new devices on a different storage node
Figure 8 on page 49 illustrates a scenario where legacy backup data from the client 
OLIVE was being stored by the storage node CASSIE in VTL format over a SAN 
connection. This data will be migrated to the new NetWorker Data Domain devices 
on the different storage node DOVE for storage on the Data Domain system.

During this migration, the SAN and the IP network are used in two separate stages. 
First, the original storage node CASSIE reads the non-deduplicated data from the 
Data Domain system over the SAN connection. Then the new storage node DOVE 
reads this data and concurrently stores only unique data, in this case the storage 
metadata, across the IP network to the Data Domain system. The speed of the transfer 
of non-deduplicated data across the IP network would be the limiting factor. 

Figure 8 Migration from VTL to NW-DD devices on a different storage node
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Figure 9 Migration from VTL to NW-DD devices on the same storage node
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Configuring Data Domain for NetWorker
Configure the Data Domain system for the NetWorker backup environment as 
described in the following sections.

Configure the Data Domain system for NetWorker
The following steps use the Data Domain CLI. The Data Domain documentation 
provides information on using the Data Domain Enterprise Manager GUI instead.

To enable a Data Domain system for storage operations with a NetWorker server:

1. Ensure the required versions and licenses are available and ready to use. “Version 
requirements” on page 17 provides details.

2. On the Data Domain system, log in as an administrative user and open the Data 
Domain CLI.

3. Verify that the filesystem and NFS services are running:

# filesys status
# nfs status

If NFS is not enabled, type the following command:

# nfs enable

Note: The DD Boost functionality requires NFS service to be enabled on the Data Domain 
system, even if no users or shares are configured. The NetWorker server, storage nodes, or 
clients are not required to be enabled for NFS.

4. If required, confirm the version number of the currently installed Data Domain 
operating system:

# system show version

5. Create the backup user and set the OST or DD Boost user name:

• For DD OS 4.9:

# user add username
# ost set user-name username

• For DD OS 5.0:

# user add username
# ddboost set user-name username

Note: Use the same username in both of these commands. Only one OST or DD Boost user 
may have access to Data Domain at a time. 

6. Add the OPENSTORAGE license key supplied by Data Domain:

# license add license_key

7. (Optional) If clone-controlled replication (“optimized cloning”) will be used, add 
the REPLICATION license key supplied by Data Domain:

# license add license_key

8. Apply the modifications by disabling and re-enabling the Data Domain services:

• For DD OS 4.9:

# ost disable
# ost enable
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• For DD OS 5.0:

# ddboost disable
# ddboost enable

9. Specify and enable users to monitor backup events captured by SNMP traps and 
add the host to receive traps:

# snmp add ro-community community_name
# snmp enable
# snmp add trap-host hostname[:port]

The typical value for community_name is “public,” which allows all users to 
monitor events.

10. Verify that distributed segment processing (DD Boost) is enabled. This is required 
for deduplication operations on the NetWorker storage nodes:

• To verify DD Boost on a DD OS 4.9 system:

# ost option show boost

• To verify DD Boost on a DD OS 5.0 system:

# ddboost option show

If DD Boost is disabled:

• To enable DD Boost on a DD OS 4.9 system:

# ost option set boost enabled

• To enable DD Boost on a DD OS 5.0system:

# ddboost option set distributed-segment-processing enabled

Note: The boost (distributed segment processing) option must be enabled. The disabled 
setting is not supported for production use. 

11. (Optional) Use the Device Configuration Wizard instead of this step. The wizard 
automatically creates a Data Domain storage unit (SU) named after the 
NetWorker server hostname if it does not already exist. This SU folder will 
contain the NetWorker Data Domain devices (device folders) for that host. 

This step is included for power users and for special configurations that require 
the manual creation of storage units, for example, to create additional storage 
units for the same NetWorker server.

To create an SU folder:

• On a DD OS 4.9 system:

# ost lsu create hostfolder_name

• On a DD OS 5.0 system:

# ddboost storage-unit create hostfolder_name

where as a best practice, hostfolder_name should be named after the short 
hostname of the NetWorker server. NetWorker Data Domain devices (device 
folders) for this NetWorker server should be located under this folder. 

Do not create any folders deeper in the folder path than these device folders.

To verify storage unit names, use the ost lsu show (DD OS 4.9) or ddboost 
storage-unit show (DD OS 5.x) command.

“Creating a NetWorker Data Domain device with the wizard” on page 55 provides 
details.
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Device locations on the Data Domain system
Use the default folder structures that are created by the NMC Device Configuration 
Wizard. The device folders are created under a storage unit folder named after the 
short hostname of the NetWorker server. The NMC view does not show the fixed 
portion of the folder path, which may be viewed on the Data Domain system. The 
storage unit folder, named for the NetWorker server hostname, is located under one 
of the following folder trees:

DD OS 4.9: /backup/ost

DD OS 5.0 and later: /data/col1

This folder structure is used by all the NetWorker Data Domain devices and should 
not be changed or modified. 

IMPORTANT

Although NFS service data is stored in the /backup directory, clients that are 
configured for NFS access have the ability to view, change, and delete the 
/backup/ost or /data/col1 directories that contain the NetWorker Data Domain 
devices. If NFS devices are used, additional configurations may be needed to avoid 
potential problems.

Configuring NetWorker for Data Domain
After a Data Domain system has been configured for the integrated environment, you 
can configure the devices, media pools, volume labels, clients, and groups that will 
use the environment. Keep the following NetWorker considerations in mind:

◆ Each NetWorker Data Domain device appears as a folder on the Data Domain 
system. Each device is identified by a unique NetWorker volume label that 
associates it with a pool. 

◆ Pools are used to direct backups or clones of backups to specific local or remote 
devices. 

◆ NetWorker groups define backup and clone schedules for member clients and are 
managed by pools. You must use dedicated groups for NetWorker Data Domain 
backups.

Methods
The Device Configuration Wizard, which is part of the NMC software, is designed to 
reduce user errors and should be used to create and configure the NetWorker Data 
Domain devices. It also creates and configures the required volume labels and storage 
pools that are necessary to store client backups on NetWorker Data Domain devices.

After a device has been created with the wizard, you may modify its configuration, if 
required, by using the individual NMC property windows:

◆ “Creating a NetWorker Data Domain device with the wizard” on page 55

◆ “Configuring a NetWorker Data Domain device with the property windows” on 
page 57.
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Creating a NetWorker Data Domain device with the wizard
The Device Configuration Wizard is designed to reduce user errors when creating 
NetWorker Data Domain devices and is the preferred method.

Note: There is no recommended limit on the number of NetWorker Data domain devices that 
may be created. However, increasing the number of devices can impact Data Domain 
performance and maintenance. Avoid the removal of devices. “Removing a NetWorker Data 
Domain device” on page 27 provides details.

To create a device with the wizard:

1. Ensure the required versions and licenses are available and ready to use. “Version 
requirements” on page 17 and “License requirements” on page 18 provide details.

2. In the NMC Enterprise view, select the NetWorker server name, and double-click 
the NetWorker application to launch it.

3. In the NetWorker Administration application, click Devices.

4. In the left panel, right-click Data Domain Systems and select New Device 
Wizard. 

On each wizard page that appears, specify the options and values required for the 
backup configuration and click Next. 

Note: To navigate to visited wizard pages to modify them, click the links in the steps panel. 
The number of steps may vary according to the type of configuration chosen. 

5. In Select the Device Type, specify Data Domain device type.

6. In Data Domain Preconfiguration Checklist, review the requirements.

7. In Specify the Data Domain Configuration Options: 

a. In the Data Domain System Name, choose the appropriate option:

– For Use an existing Data Domain system, select an existing system.
– For Create a New Data Domain system, specify the fully qualified domain 

name, or IP address, of the Data Domain system.
b. In Data Domain OST Username and Data Domain OST Password, specify 

the username and password, respectively.

Note: Only one Data Domain OST username and password may be defined. All 
NetWorker storage nodes and servers that access the Data Domain system must use the 
same username and password. “Configure the Data Domain system for NetWorker” on 
page 52 provides details on setting the OST username.

c. In Configuration Type, select Browse and Select.

8. In Select Folders to use as Devices, create a new NetWorker Data Domain device 
folder:

Note: The wizard does not show existing device folders that were previously created by 
NetWorker 7.6 SP1.

a. Select a top-level folder (the Data Domain system) and click New Folder.

A new device folder appears in the folder tree.
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Note: For NetWorker 7.6 SP2 and later, the folder tree (not updated from NetWorker 
7.6 SP1), does not show the storage unit (SU) folder under the Data Domain system 
folder. The wizard names this SU folder after the short hostname of the NetWorker 
server and places devices within this SU folder. The SU folder is verifiable in the 
Review Configurations Settings wizard page.

b. Type a name for the new device folder.

To list the details of any device folder, select its checkbox. The table displays 
the full NetWorker Device Name and the Storage Unit name. 

Note: For NetWorker 7.6 SP2 and later, the Storage Unit label (not updated from 
NetWorker 7.6 SP1) actually refers to the device name.

c. (Optional) To rename a NetWorker Data Domain device, as it will appear in 
NMC, select it in the table and type a new name in the NetWorker Device 
Name attribute. No special characters are permitted other than dot “.” or 
underscore “_”. The Storage Unit attribute remains unchanged.

Note: Implicit in the path to the SU folder on the Data Domain system are the hidden 
mount point folders: /backup/ost (DD OS 4.9) or /data/col1 (DD OS 5.0 and later). This 
folder structure is used by all NetWorker server hosts and should not be modified. The 
Review Configurations Settings wizard page shows this location.

9. In Configure Pool Information:

• Ensure Configure Media Pools for Devices is selected.

• Specify the pool that will target clients to the devices, either Backup for 
backups or Backup Clone for cloning or staging operations, or create a new 
pool.

Note: If you create a new pool, do not select an existing pool.

• Ensure Label and Mount device after creation is selected.

10. In Select Storage Nodes, select or create the storage node that handles the 
devices.

11. In SNMP Monitoring Options, type the Data Domain SNMP community string 
and specify the events to be monitored.

If the community is not known, unselect Gather Usage Information.

SNMP monitoring allows NMC to display the Data Domain system status and 
monitor backup and recovery events. It also provides a launcher link for the Data 
Domain interface.

12. In Review Configuration Settings, review the information and click Configure.

Note: For NetWorker 7.6 SP2 and later, the Storage Unit name (not updated from 
NetWorker 7.6 SP1) is actually the path for the device folder in the format: SU/device_name, 
where SU is named after the short hostname of the NetWorker server.

The NetWorker Data Domain device will be configured, mounted, and labeled for 
the specified pool.

13. The final Device Configuration Results page is informational only. Click Finish 
to exit the wizard.
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14. In the NMC Devices view, verify that the device is labelled and mounted, ready 
for use. This view should list the device with its appropriate Volume Name.

To show or hide the read-only components of the devices, click View > Display 
read-only devices and volumes.

Configuring a NetWorker Data Domain device with the property windows
The Device Configuration Wizard is the recommended method to create NetWorker 
Data Domain devices. You may modify the devices and perform other tasks by 
following the manual procedures in the following sections:

◆ “Add a host Data Domain system to NMC Enterprise view” on page 57
◆ “Configure a NetWorker Data Domain device” on page 58
◆ “Create a volume label template for NetWorker Data Domain devices” on page 60
◆ “Create pools to target NetWorker Data Domain devices” on page 61
◆ “Label and mount devices on the storage node” on page 62

Add a host Data Domain system to NMC Enterprise view
Normally, a Data Domain host is added to the NMC Enterprise view by the Device 
Configuration Wizard. As an alternative, a host may be added by the Add New Host 
Wizard.

Data Domain systems that are used for storage with NetWorker software should be 
listed as hosts in the NMC Enterprise view. This allows NMC to display the Data 
Domain system status and monitor events during backup and recovery operations. It 
also provides you with a live link that launches the Data Domain GUI.

To add a host Data Domain system to the NMC Enterprise view:

1. From the File menu, select New > Host to run the Add New Host wizard.

2. Follow the wizard screens: 

• Type the Data Domain Host Name

• Select Data Domain

• Select Capture Events

• Type the SNMP community string, where NMC will retrieve Data Domain 
status information. The default is the value set on the Data Domain system 
with the snmp add ro-community community_name command. “Configure the 
Data Domain system for NetWorker” on page 52 provides details.

• Type a value for the SNMP Process Port. The default is the value set on the 
Data Domain system with the snmp add trap-host hostname[:port] command. 
“Configure the Data Domain system for NetWorker” on page 52 provides 
details. This setting should agree with the firewall setting on the Data Domain 
system. 

• Select the SNMP Traps that you want to monitor. 

“Configure Data Domain monitoring and alerts” on page 78 provides details on 
monitoring and alerts.
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Configure a NetWorker Data Domain device
Normally, NetWorker Data Domain devices are created by the Device Configuration 
Wizard. The devices appear as folders on the Data Domain system. You may use this 
manual procedure to modify an existing device.

Note: If you manually create a device with this procedure, NMC will list the device but no 
corresponding device folder will be created on the Data Domain system. If you try to label such 
a device, an error appears. “Configure the Data Domain system for NetWorker” on page 52 
provides an optional step to manually create a storage unit on the Data Domain system.

To modify a NetWorker Data Domain device:

1. Ensure that the required versions and licenses are available and ready to use. 
“Version requirements” on page 17 and “License requirements” on page 18 
provide details.

2. In the NetWorker Administration window, click the Devices view. Ordinarily, 
Display Read-Only Devices and Volumes is not selected in the View menu.

3. In the folder tree, expand Data Domain Systems and select the Data Domain 
system where your save sets are stored.

4. In the right panel, right-click the name of the device to modify and select 
Properties. 

5. In the Identity group, type the NetWorker Data Domain device name and access 
information. For example, the following values are used in Figure 10 on page 58:

NetWorker server short hostname = nw_gidrathy
NetWorker storage node hostname = nw_gidrathy_sn1
Data Domain hostname = dds_tenendo
NetWorker Data Domain device = mydd_1

Figure 10 Configure a NetWorker Data Domain device on DD 5.0
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a. In the Name attribute, type a name for Data Domain device.

For example: 
mydd_1

If the device is configured on a separate storage node host that is not the 
NetWorker server host, it is a “remote device” and this Name attribute must 
be in the following format: rd=storagenode_hostname:device_name

For example: 
rd=nw_gidrathy_sn1:mydd_1

b. In the Device access information attribute, type the Data Domain hostname 
followed by a colon and the folder path to the device.

Use the following format: 
DD_hostname:/DD_storage_unit_name/device_name

where, as a best practice, DD_storage_unit_name is the short hostname of the 
NetWorker server and device_name is a name for the device, which will appear 
as a folder. Do not create folders within a device folder. There is no 
recommended limit on how many device folders may be created, but this 
attribute accepts one device folder only.

For example:
dds_tenendo:/nw_gidrathy/mydd_1

Note: Implicit in this path are the hidden mount point folders: /backup/ost (DD OS 
4.9) or /data/col1 (DD OS 5.0 and later). This folder structure is used by all NetWorker 
server hosts and should not be modified.

c. In the Media type attribute, select Data Domain from the list.

Note: Each Data Domain system NIC that is used as device with the Media type 
attribute set to Data Domain will require a Data Domain Storage System Enabler. 
“License requirements” on page 18 provides details.

6. Do not select Auto media management. It does not apply to NetWorker Data 
Domain devices.

7. In the Remote user and Password attributes, type the Data Domain OST 
username and password, respectively. This allows NetWorker interfaces to 
connect to the Data Domain interface.

Only one OST user may be defined. All NetWorker storage nodes and servers that 
access the Data Domain system must use the same username and password.

8. On the Configuration tab, set the number of concurrent save or clone streams 
(sessions) the device may handle:

• Target sessions are the number of sessions that the NetWorker storage node 
may send to this device before the storage node looks for another available 
device. This should be set to a low value for best performance. The default 
setting is 1 and it may not be set to a value greater than 60.

• Max sessions is set by default to a value of 10, which in most cases provides 
best performance. It may not be set to a value greater than 60.

9. On the Advanced tab, ensure that common device interface (CDI) is set to Not 
used with No reserve release. 
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10. Click OK to save the device settings.

The NetWorker Administration window displays the Data Domain system and 
details of the device. 

Ensure that the device is labeled and mounted before attempting to use it, otherwise 
an error appears. “Label and mount devices on the storage node” on page 62 
provides details.

Create a volume label template for NetWorker Data Domain devices
Normally, the Device Configuration Wizard automatically creates a label template for 
the volumes a new device will use. This procedure describes the alternative manual 
method that uses the NMC property windows. 

Note: The Device Wizard automatically creates a label template for the volumes and this 
procedure does not apply if the wizard is used.

Each NetWorker Data Domain device must be mounted with a storage volume, 
which associates it with a specific Volume Name and membership within a pool. A 
label template must be created to provide a Volume Name and numbering to all 
storage volumes that belong to the same pool. 

A label template defines the components of a volume label. All the volumes in the 
same pool will have the same label name (for example, “dd_myvol”), but different 
volume numbers (for example, .001–.003).

For example, a Data Domain system may have three devices, each of which is 
mounted with a storage volume (Volume Name). If each device/volume is associated 
with the same pool, the Volume Names would be as follows:

◆ dd_myvol.001
◆ dd_myvol.002
◆ dd_myvol.003

To create a volume label:

1. From the NetWorker Administration window, click Media.

2. In the browser tree, select Label Templates, and from the File menu, click New to 
open the Create Label Template window.

3. In the Name and Comment attributes, type a name and description for the label 
template. The label will associate a storage pool to a device. 

4. In the Fields attribute, type components of the label. Place each label component 
on a separate line. The template must include at least one volume number range 
component. The label template will be applied to the volumes mounted on 
NetWorker Data Domain devices in a Data Domain system.

For example: 

dd_myvol
001-999

5. Select a Separator and click OK.

6. In the Next attribute, specify the next Volume Label in the sequence to be to be 
applied during the next label and mount operation. For example, dd_myvol.001.

7. Click OK.
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Create pools to target NetWorker Data Domain devices
Normally, the media pool is automatically created by the Device Configuration 
Wizard. The following procedure describes the alternative manual method that uses 
the NMC property windows.

Each NetWorker client stores data to a media or “target” pool. This pool is used to 
direct the data from backup clients, or the data from storage volumes in clone 
operations, to the storage devices that are members of the pool. 

Each NetWorker Data Domain device is associated with a storage volume (Volume 
Name) when it is labeled. The Volume Name implicitly associates the device with the 
specified pool.

Note: Dynamic Drive sharing (DDS) is not supported for NetWorker Data Domain devices.

To manually create a pool for Data Domain backups by using the property windows:

1. Ensure that the devices that will target the pool have already been created. If you 
do not use the Device Configuration Wizard to create the devices, “Configure the 
Data Domain system for NetWorker” on page 52 provides details.

2. Ensure a label template has been created for the pool. “Create a volume label 
template for NetWorker Data Domain devices” on page 60.

3. From the NetWorker Administration window, click Media.

4. In the browser tree, select Media Pools, and from the File menu, select New to 
open the Create Media Pool window with the Basic tab selected.

5. In the Name attribute, type a name for each pool. Create names that clearly 
indicate whether the pool is for Data Domain backup or clone operations.

For example: 

DDsite1
DDCLsite2

For example, a pool name that starts with DD would be a Data Domain pool, and 
a pool name that starts with DDCL would be a Data Domain clone pool. The pool 
name can also include the physical location where the backup will be stored. 
These conventions make the name easier to use for scripting and reporting.

6. In the optional Comment attribute, type a description of the pool.

7. Select Enabled.

8. Select the Pool type:

• To use the pool for backups, select Backup. 

• To use the pool for clone copies, select Backup Clone. 

Note: Pool type cannot be modified after it is created. 

9. In the Label Template attribute, select a label template, created earlier, to 
associate with the pool. 

The pool will later be applied to NetWorker Data Domain devices. “Label and 
mount devices on the storage node” on page 62 provides details.

10. In the Data Source attribute, select the groups (and the implicit backup 
schedules) that the clients in this pool may belong to. 
Configuring NetWorker for Data Domain 61



Software Configuration
An alternative way to configure a client to use a pool is to specify the Target Pool 
attribute of the client resource. “Configure a backup client with the client wizard” 
on page 63 provides details.

Note: A client may belong to multiple groups through multiple client definitions. 

11. Click the Selection Criteria tab.

12. Under Target Devices, select all of the NetWorker Data Domain storage devices 
that this pool may use. The pool may store data on any of these devices.

You must select both the storage device and its corresponding read-only device, 
which is appended with the “/_AF_readonly” suffix:

• Select only NetWorker Data Domain storage devices for the pool. Do not mix 
with other types of storage devices. The pool Selection Criteria may also 
include client attributes that need to be removed or updated.

Note: If you modify an existing pool in this step, ensure that the pool excludes all 
devices that are not NetWorker Data Domain devices.

• Do not select devices on more than one Data Domain system. 

Otherwise, backups from a single NetWorker client may be targeted to any of 
these Data Domain system. This will impair the backup window and 
deduplication ratio. 

13. Under Media type required, if the pool is intended for Data Domain backup, set 
this attribute to Data Domain. This ensures that only Data Domain devices can be 
associated with this pool.

Note: As a best practice, do not include different media types in a single pool. “Backup fails 
for older NetWorker application modules” on page 86 provides further details.

14. Click OK.

The EMC NetWorker Administration Guide provides details on media pools.

Label and mount devices on the storage node
Normally, devices are labeled and mounted by the Device Configuration Wizard. The 
following procedure describes the alternative manual method that uses the NMC 
property windows.

A NetWorker Data Domain device must be identified with a volume label (Volume 
Name) and its associated pool, and must be mounted for use by the NetWorker 
storage node.

To label and mount a device:

1. From the NetWorker Administration window, click Devices.

2. In the browser tree, select the Data Domain system.

3. In the right panel, right-click the device to be labeled and select Label.

4. In the Label window, Pools list box, select a pool to associate with the device.

A label for the selected pool appears in the Volume Label attribute. This will 
become the Volume name that is applied to the device.
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5. Select Mount After Labeling and click OK.

The NMC list shows the device with its associated Volume name.

The EMC NetWorker Administration Guide provides details.

Configuring clients to back up to Data Domain
The NMC software provides different methods to create NetWorker clients and their 
schedules. The wizard method is recommended, but you may use the individual 
property windows method as described in the following sections.

Configure a backup client with the client wizard
The NetWorker Client Configuration Wizard is designed to reduce user errors and is 
the preferred method when creating and configuring NetWorker backup clients and 
their backup schedules. This procedure describes the alternative method that uses 
individual property windows.

To create or modify a client and its scheduled backup with the wizard:

1. In the NMC Enterprise view, select the NetWorker server name, and double-click 
the NetWorker managed application to launch it.

2. In the Configuration view, under the NetWorker server name, right-click Clients 
and select Client Backup Configuration > New.

3. Follow the instructions on the wizard pages:

• Show the Client Name.

• Specify the Backup Configuration Type.

• Specify the Backup Options:

– In the Deduplication settings, select Data Domain Backup, if applicable. 
This setting ensures that the client will back up to Data Domain devices if 
the pool used also contains other types of devices, although pools with 
mixed devices is not recommended.

– Set Target Pool to a pool that is associated with Data Domain devices. 
An alternative way to configure a client to use a pool is to specify the client 
or its group in the Data Source attribute of the Pool resource. “Create pools 
to target NetWorker Data Domain devices” on page 61 provides details.

Note: NetWorker application modules support backup to NetWorker Data Domain 
devices, although the older modules do not support the client attributes for Data 
Domain backup and Target Pool and these attributes should not be set. “Backup fails 
for older NetWorker application modules” on page 86 provides details. 

• Select Files to Back Up.

• Select the Client Properties.

• Select the Backup Group.

• Specify the Storage Node Options.

“Configure a backup client with the property windows” on page 64 provides details 
on settings for backups to NetWorker Data Domain devices.
Configuring NetWorker for Data Domain 63



Software Configuration
Configure a backup client with the property windows
As an alternative to the client wizard method, new or existing NetWorker backup 
clients may be configured for the NetWorker for Data Domain backup environment 
by using the individual NMC client configuration windows.

To configure a NetWorker client for scheduled backups to a NetWorker Data Domain 
device:

1. In the NMC Enterprise view, select the NetWorker server name and double-click 
the NetWorker application to launch it.

2. In the NetWorker Administration window, click Configuration.

3. In the browser tree, select Clients:

• To create a new Client resource, select the Clients icon and from the File 
menu, click New. 

• To edit an existing client resource, select the client name from the list in the 
right panel and from the File menu, select Properties.

4. Skip this step unless you are creating a new Client resource. The following 
attributes do not need to be modified for clients whose backups have been 
redirected to NetWorker Data Domain devices:

a. In the Name attribute, type the hostname for the client and, optionally, type a 
comment in the Comment attribute.

b. Select values for Browse Policy and Retention Policy:

– The browse policy determines how long the details of individual 
backed-up files are maintained in a browsable index for quick recovery 
through the GUI or command line. 

– The retention policy determines how long backed-up data is protected and 
available for recovery even though the browse policy has lapsed. Recovery 
might require rebuilding an index.

c. Select the Scheduled Backups checkbox.

d. In the save sets attribute, click Browse to open the Choose Directory window. 
Browse to and select all the directories or individual files to be backed up. 
When finished selecting, click OK.

Each item should appear on a separate line. For example:

accounting
sales

To back up all client data, type All in the save sets attribute. 

Note: For Microsoft Windows systems, the SYSTEM or Volume Shadow Copy Service 
(VSS) SYSTEM save sets should be backed up on a regular basis for disaster recovery of 
the client system. 

The EMC NetWorker Administration Guide provides details for this step.

5. In the Group attribute, select a backup group. A backup group consists of clients 
that are backed up according to the schedule for the group.

This attribute may show groups pre-selected based on the pool selected. It is 
recommended to not separate groups from their associated pools at the client 
level.
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Note: Groups that are specifically devoted to deduplication backups help you monitor 
deduplication operations and configure backup schedules for either deduplication or 
traditional storage.

6. In the Pool attribute, select a pool that targets the NetWorker Data Domain 
devices you want to use. The pool selected in this attribute overrides any other 
pool that might be configured for the client or its save sets. 

An alternative way to configure a client to use a pool is to specify the client or its 
group in the Data Source attribute of the pool resource. “Create pools to target 
NetWorker Data Domain devices” on page 61 provides details.

7. (Optional) A Data Domain backup applies only to the save sets (the data portion 
of backups), and does not back up the NetWorker server’s bootstrap and index 
files to a Data Domain device. Normally, the bootstrap and index files are backed 
up to a traditional disk or tape device that is locally attached to the NetWorker 
server.

If you want to back up the bootstrap and index files to a NetWorker Data Domain 
device, create a Pool resource specifically for them. In the pool’s save sets 
attribute, specify the following:

bootstrap*
index*

8. In the Schedule attribute, select a backup schedule.

The schedule selected in this attribute overrides any other schedules that might 
be configured for the client or its save sets.

9. Select the Apps & Modules tab.

10. In the Deduplication attributes group, select Data Domain backup. This ensures 
that the client data will be backed up only to NetWorker Data Domain devices, 
even if the pool selected for the backups contains a mix of other device types, 
although pools with mixed devices is not recommended. 

Note: NetWorker application modules support backup to NetWorker Data Domain 
devices, although the older modules do not support the client attributes for Data Domain 
backup and Pool and these attributes should not be set. “Backup fails for older NetWorker 
application modules” on page 86 provides details. 

11. For NDMP deduplication clients, ensure that the -M option is used with the 
nsrndmp_save command, which is specified in the Backup Command attribute. 
The -M parameter will look for NetWorker Data Domain devices. The EMC 
NetWorker Administration Guide provides details.

12. Click the Globals (2 of 2) tab.

13. In the Storage nodes attribute, specify storage nodes that the client will back up 
to, especially if this client backs up to a remote storage node.

14. In the Clone storage nodes attribute, if this client is a source storage node for 
clone operations, specify the target storage node where the clones will be stored.

15. When you have completed the client configuration, click OK. 

In the NetWorker Administration window, the configured client shows a 
checkmark in the Scheduled backup column to indicate that scheduled backup is 
enabled.
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The EMC NetWorker Administration Guide provides complete details on NetWorker 
Client resource configurations.

Deactivating a device
To deactivate a device so it does not interfere with normal backup operations, use any 
of the following options:

◆ “Convert a read-write device to be read-only” on page 66
◆ “Disable a device” on page 66
◆ “Remove a device” on page 66

Convert a read-write device to be read-only
Conversion of a read-write device as read-only prevents the use of the device for 
backup operations. The device can still be used for read operations, such as restore 
and clone. To convert a read-write device to be read-only:

1. In the NetWorker Administration window, click the Devices view and select the 
Devices folder in the navigation tree.

2. In the View menu, ensure Display Read Only Devices and Volumes is selected. 

Both the read-write and the corresponding read-only components of all the 
devices should be listed in the Devices table.

3. In the Devices table, right-click the read-write component and select Unmount.

4. Right-click this component and select Properties.

5. In the Device Properties window, select Read only and click OK.

6. Right-click this component and select Mount.

Disable a device
Disabling a device prevents further operation of the device. The device may be 
re-enabled to restore old data, which is retained but is not active. To disable a device:

1. In the NetWorker Administration window, click the Devices view and select the 
Devices folder in the navigation tree.

2. In the View menu, ensure Display Read Only Devices and Volumes is selected. 

Both the read-write and the corresponding read-only components should appear 
in the Devices table.

3. Perform the following steps for both the read-write and read-only components:

a. In the Devices table, right-click the device and select Unmount.

b. Right-click this device and select Enable/Disable to disable. 

4. Inspect the Enabled column of the table to verify the device is disabled.

Remove a device
Special procedures are required to remove NetWorker Data Domain devices. 
“Removing a NetWorker Data Domain device” on page 27 provides details.
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About cloning and replicating with Data Domain
For added data protection, save sets that have been successfully written to a 
NetWorker Data Domain device can be copied to a different location with the 
NetWorker clone feature. A clone is a complete and independent copy of the data, 
which can be used for data recovery or to create further clones. Single save sets or the 
entire volume of a NetWorker Data Domain device may be cloned. A NetWorker 
clone retains the original NetWorker browse and retention policies by default, but 
these can be changed to allow the clone copy to have different policies.

Datazone requirement
A clone of stored data may not be created in a different NetWorker datazone. For the 
NetWorker server to manage and monitor clone operations, the storage nodes at both 
the source and target locations must be clients of the same NetWorker server. The 
NetWorker server maintains browse and retention policies for all cloned copies and 
can monitor and report on their storage operations.

Clone pool
In order for the NetWorker software to copy save sets from one device to another, a 
special pool must be created. This pool, known as a “clone pool,” is assigned to 
devices on the target system. It must be properly configured and available for use. 
“Create pools to target NetWorker Data Domain devices” on page 61 provides 
details. The EMC NetWorker Administration Guide provides additional details.

Data Domain native replication support
As a recommendation, replication of data on NetWorker Data Domain devices should 
use NetWorker clone-controlled replication. This allows the data to be tracked and 
maintained by the NetWorker software. “Clone-controlled replication format” on 
page 69 provides details.

The replication operations that are native to Data Domain systems are typically used 
to copy deduplicated data stored in CIFS, NFS, or VTL formats from one Data 
Domain system to another for disaster recovery purposes. These native operations 
are independent of NMC and NetWorker. They provide copies of data without 
NetWorker knowledge or control. 

Note: If Data Domain replication is used for other (non-DD Boost directories) on the same 
system, ensure that there is adequate network load and bandwidth capacity such that 
NetWorker clone-controlled replication operations will not be impaired.

Native Data Domain replication support for DD Boost devices is as follows:

◆ Native Data Domain directory replication is not supported for DD Boost devices.

◆ Native Data Domain MTree replication is not supported for DD Boost devices. 
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◆ Data Domain collection replication (the replication of the entire stored contents of 
a Data Domain system) is supported and will replicate the DD Boost devices and 
stored data onto a target Data Domain system. However, the target Data Domain 
system cannot be the same system that is used for other replication operations 
such as NetWorker clone-controlled replication.

IMPORTANT

If collection replication is performed, the Data Domain devices on the target 
system become read-only and NMC and NetWorker will not be aware of any 
DD Boost devices on the target system. NetWorker awareness and recovery 
from the target Data Domain system would require further procedures, testing, 
and qualifications to be performed. EMC Professional services are strongly 
recommended.

Clone reports
NetWorker Data Domain clone operation reports can be viewed in the NMC Reports 
view.

“Backup, recovery, and clone reports” on page 81 provides details.

Clone formats
Copies of data stored on a NetWorker Data Domain device may be created by the 
NetWorker clone process. The type of clone produced depends on the type of media 
on which the clone copy will be stored, whether a clone-controlled replication or a 
regular clone.

Clone-controlled replication format
Data that is cloned from a source NetWorker Data Domain device to a target 
NetWorker Data Domain device, typically at a geographically distant location, retains 
its deduplication format and NetWorker policies. This is called “clone-controlled 
replication,” “optimized clone,” or “DD format clone.” 

A clone created in this format may be used for data recovery or to create further 
copies. For example, further clones may be created to multiple Data Domain systems, 
or copies may be made to traditional disk or tape storage, with minimal impact on 
production or primary backup and recovery operations.

An optimized clone is created quickly and uses low bandwidth and low storage 
capacity. During the cloning process, the storage node for the target NetWorker Data 
Domain device reviews the incoming clone for data that is already stored on the 
target device and transfers only unique data and reference pointers to be stored on 
the device. 

NetWorker control ensures that clone-controlled replication will not begin until after 
the related backup group at the source has finished its backup.

Note: A NetWorker Data Domain device that is used to store clone-controlled replications 
should not also be used to store normal backups.
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Regular clone format
When data on the NetWorker Data Domain device is cloned to a traditional disk or 
tape, it is reverted to its native non-deduplicated format, known as “regular clone” 
format. Regular clone format is necessary for the data on traditional disk or tape 
storage to be completely recoverable, for example for disaster recovery, without the 
need of a Data Domain system.

Clone methods
NetWorker clone operations may be configured by several methods, which are 
suitable to different environment and storage needs. In some cases, it may be 
necessary to use multiple or mixed approaches to achieve the desired control and 
flexibility.

As choices, you can configure clone operations to be run by automatic start 
(auto-clone), by a schedule, or by a customized script.

Immediate clone
Also known as “auto-clone.” Save sets can be automatically cloned when the backup 
group that contains them is completed. This clone method is suitable for smaller 
environments, or a small number of clients, where the clone operations need to be 
completed quickly and immediately within the backup window:

1. In the NetWorker Administration window, select Configuration. 

2. Create a Group resource and specify the Clones option and Clone pool. 

“Create pools to target NetWorker Data Domain devices” on page 61 provides details 
on creating a clone pool.

Scheduled clone
NetWorker scheduled clone operations can be configured and run in NMC according 
to a schedule for predetermined clients, pools, save sets, and devices. This method is 
suitable for environments where copies of save sets need to be regularly provided, 
typically as part of a well-defined maintenance cloning window, which runs 
independently of the main backup operation. 

“Scheduling a clone operation” on page 72 provides details.

nsrclone command
A NetWorker nsrclone script can be created and used to run clone operations and be 
launched either manually or as a scheduled task run from the operating system or an 
external scheduler. This method is typically used in larger environments where 
flexibility and conditional controls are required. 

One example would be to start Clone Job B, which clones to tape storage, if and only 
if Clone Job A successfully completes. Another example would be to select multiple 
specific save sets to be cloned to specific devices or storage nodes.

Scripted solutions require additional knowledge and have external dependencies, 
such as operating system, scripting tool, and so forth. 
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The EMC NetWorker Administration Guide and the EMC NetWorker Command Reference 
Guide provides details. EMC Professional Services are also available.

Clone requirements
To clone data from one Data Domain device to another by NetWorker 
clone-controlled replication (optimized cloning), ensure that the following 
requirements are met. These requirements assume the previous creation of a clone 
target pool, for example, named newclonepool:

1. Ensure that both the source and target storage nodes are clients of the same 
NetWorker server.

2. Ensure that the Data Domain systems are properly licensed, including a 
Replication license, which is required to create optimized clones. 

“Configure the Data Domain system for NetWorker” on page 52 provides details.

3. Ensure that the Client resource for the NetWorker server and both storage nodes 
specify, in their Aliases attribute (Globals 1 of 2 tab), all of their names in use 
(fully qualified name, short name, aliases, and IP address). 

Note: If a nsrclone command or script is used to perform an optimized clone from a host 
that is not the NetWorker server, then this command must specify the NetWorker server by 
its primary hostname (as listed in the NMC Enterprise view). Otherwise, a regular clone 
might be produced instead of an optimized clone.

4. Ensure that a target pool (for example, newclonepool) has been created for Backup 
Clone type with the Media type required attribute set to Data Domain. 

With this setting, if a Data Domain device is not available for a clone operation in 
the specified target pool, then NMC displays a “Media waiting” message.

Note: The Default Clone pool does not allow any modification and Media type required 
cannot be set in that pool. The use of the default clone pool is not recommended.

“Create pools to target NetWorker Data Domain devices” on page 61 provides 
details on creating pools.

5. Ensure that the Client resource for the source storage node specifies, in its Clone 
storage node attribute, the target storage node hostname. This setting is not 
required if the target storage node is on the Networker server. 

If the Clone storage node attribute is not specified, then the NetWorker server 
becomes the storage node for the clone operation. 

If the Clone storage node attribute lists a storage node for a non-Data Domain 
volume, and Media type required is not set to Data Domain in the target clone 
pool, then only regular clones may be stored on those volumes. 

6. Ensure that the source NetWorker Data Domain device is mounted and available 
on the source storage node.

If the source device is not mounted, then a regular, non-deduplicated clone will be 
performed, except if the specified target pool is of Backup Clone type with the 
Media type required attribute set to Data Domain.

7. Ensure that the target NetWorker Data Domain device is labeled and mounted on 
the target storage node. The pool selected for the device label operation (for 
example, newclonepool) must be of Backup Clone pool type. 
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8. Verify that the target clone pool (for example, newclonepool) is properly specified 
or selected:

• For CLI clone operations, use the nsrclone -b newclonepool command.

• For scheduled clone operations, in the Write clone data to pool attribute of the 
Clone resource, select newclonepool.

• For immediate clone operations for a group, in the Clone pool attribute of the 
Group resource, select newclonepool.

• For clones of entire volumes, “Cloning by pools” on page 74 provides details.

9. Ensure that Data Domain encryption is disabled on both the source and target 
Data Domain devices and that there is sufficient bandwidth available for the 
clone operation. 

Scheduling a clone operation
To configure NMC for a clone operation to be performed at a scheduled time, for 
either a clone-controlled replication (also known as optimized clone or DD format 
clone) or a regular (non-deduplicated) clone:

1. Ensure the requirements for cloning are met. “Clone requirements” on page 71 
provides details.

2. From the NetWorker Administration window, click Configuration.

3. In the browser tree, click Clones, and from the File menu, select New to open the 
Create Clone window. Figure 11 on page 73 shows the General settings.

4. In the Name attribute, create a unique name to identify your scheduled Clone 
resource. Type any additional information in the Comment attribute.

5. Set the Browse Policy and Retention Policy attributes if you want the clones to 
use different policies than the original backup.

6. In the Write clone data to pool attribute, specify the clone pool that targets the 
devices on which the clones will be stored.

7. If diagnostic mode is enabled, values may be assigned to the Storage node to 
WRITE save sets and the Storage node to READ save sets attributes. These 
attributes enable multiple storage nodes to be used as targets or sources.

8. To skip invalid save sets, select Continue on save set error. If not selected (default 
setting), an invalid save set will stop the clone operation and generate an error 
message.

9. The Limit number of save set clones attribute has a default value of 1. This 
allows only one clone to be made to the target pool for each save set. 

This setting of 1 is useful, for example, if you need to manually restart an 
interrupted clone operation, and you want to produce only the missed clones but 
do not want to reproduce clones that were already successful.

This attribute limits the number of clones of each save set that may be produced 
in the clone pool for a scheduled clone operation. A zero (0) setting allows an 
unlimited number of duplicate clones.

Note: The NetWorker software allows only one unique save set clone to be stored on a 
single volume. If multiple clones of the same save set are created, each will be stored on a 
different volume in the pool.
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10. Configure the schedule for the clone operation. Figure 11 on page 73 shows the 
settings for a schedule.

Typically, to reduce the use of resources, you would schedule clone operations to 
be performed after the backup window has completed:

a. Select Enable to enable the clone operation to run at its scheduled times.

b. In the Start Time attribute, click the spin arrows, or type values, to set the start 
time.

c. Select either Weekly by day or Monthly by day to display either a calendar 
week or a calendar month. In the calendar, select the days on which you want 
the clone operation to run.

d. To repeat the clone operation within a day, specify an Interval time in hours. 
For example, if the start time is 6 a.m., and the interval is 6 hours, then the 
clone operation will run at 6 a.m., 12 p.m., and 6 p.m. 

If the Limit the number of save set clones value is set, then the repeat clone 
operation will fail after the limit is reached.

Figure 11 Clone properties, general settings

11. Select the Save Set Filters tab and specify the source save sets to include in your 
scheduled clone operation. 

There are two main options as follows:

• Select Clone save sets that match selections and limit the save sets to be 
cloned by specifying the following details:

– save groups
– NetWorker clients
– pools
– save set levels
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– save set name, as specified in the NetWorker Client resource
– save sets from the past number of days, weeks, months, or years

• Select Clone specific save sets and type the names of the source save sets to be 
cloned, either by save set ID (ssid) or by clone ID (clonid). Use a separate line 
for each save set name.

To find save set and clone IDs, in the NetWorker Administration window, 
click Media, select save sets in the browser tree, and specify values for your 
search. Alternatively, you may use the NetWorker mminfo command. The 
EMC NetWorker Administration Guide provides details.

12. Click Preview Save Set Selection to review save set filter settings.

13. Select OK to save the scheduled clone operation.

14. After the clone operation completes, verify the cloned data on the target devices. 
If required, test selected save sets to ensure they can be restored to the client hosts.

Chapter 6, “Monitoring, Reporting, and Troubleshooting,” provides details on the 
verification of NetWorker operations and the monitoring of clone operations, in 
the NMC Clones window, similar to a group.

Cloning by pools
To copy save sets from Data Domain storage to a device, a special pool may be 
specified. This pool is know as a “clone pool.” A clone pool must be assigned to a 
device on the target Data Domain system, where it will be available for use. There are 
two main purposes for a clone pool:

◆ To copy existing deduplicated VTL or CIFS/NFS AFTD save sets to a NetWorker 
Data Domain device.

◆ To copy the existing save sets from one NetWorker Data Domain device to 
another NetWorker Data Domain device, typically at a remote location for 
disaster recovery purposes.

Note: Selection of the volumes, pools, or save sets for a clone operation must ensure that all 
appropriate save sets are identified and successfully cloned. Failure to clone the entire backup 
set may result in a failure to perform a recovery from that clone copy. Expiration or deletion of 
the primary save sets should be performed only when you are confident that all save sets have 
been successfully cloned.

To specify a clone pool for the source volumes:

1. Ensure that cloning requirements are met. “Clone requirements” on page 71 
provides details.

2. Create a clone pool. 

“Create pools to target NetWorker Data Domain devices” on page 61 provides 
details.

3. In NetWorker Administration window, click the Media view.

4. Click Disk Volumes and select volumes to clone.

5. Right-click and select Clone.

6. In the Source volumes to clone window, in the Target clone media pool list box, 
select the name of the clone pool, for example, newclonepool.
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7. Once the pool is defined, the clone copies may be configured and run as a 
scheduled clone operation or manually started. “Scheduling a clone operation” 
on page 72 provides details.

Starting a scheduled clone operation manually on demand
You can start a scheduled clone operation at any time without affecting the 
regularly-scheduled start time. There are two methods as follows:

Manually start a clone operation from the Configuration window
To manually start a scheduled clone operation:

1. From the Administration window, click Configuration.

2. In the browser tree, select Clones.

3. Right-click a clone resource in the right panel listings and select Start.

Manually start a clone operation from the Monitoring window
To manually start a scheduled clone operation:

1. From the Administration window, click Monitoring.

2. Select the Clones tab.

3. Right-click a clone resource and select Start.
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Monitoring NetWorker Data Domain devices
NMC provides the ability to monitor details of current Data Domain backup 
operations and display events that require user intervention. 

Configure Data Domain monitoring and alerts
The status and events for a Data Domain host can be monitored from the NMC 
Enterprise view and Events view. 

Note: On NMC servers with HP-UX operating systems, status monitoring (SNMP) in the 
Enterprise view is supported, but event monitoring (SNMPTRAP) in the Events view is not 
supported. 

To configure NMC to monitor Data Domain backup status and events (SNMP traps):

1. Provided you have viewing privileges, the NMC Enterprise view should list the 
Data Domain systems as network hosts. “Add a host Data Domain system to 
NMC Enterprise view” on page 57 provides details.

2. Ensure that SNMP is enabled on the Data Domain system and Data Domain 
system is configured to send traps to NMC server. “Configure the Data Domain 
system for NetWorker” on page 52 provides details.

3. In the NMC Enterprise view left panel, right-click the Data Domain system to be 
monitored and select Properties. The Properties window opens.

4. On the Manage Data Domain tab, select Capture Events. 

If the box is not checked, NMC will monitor the status of the NetWorker Data 
Domain devices, but will not monitor Data Domain SNMP traps, required to 
monitor event.

5. On the Configure SNMP monitoring tab, type a value for SNMP Community 
String. The typical setting is “public,” which allows all users to monitor events. 
Figure 12 on page 79 shows an example.

6. Type a value for the SNMP Process Port. The default value is 162. This setting 
should agree with the firewall setting on the Data Domain system. 

7. Select the appropriate SNMP Traps that you want to monitor. Some traps are 
pre-selected. Figure 12 on page 79 shows an example for Data Domain 4.8 alerts. 
Other versions may differ.

8. Click OK.
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Figure 12 Data Domain alerts to monitor

Monitor Data Domain operations in the Devices view
Figure 13 on page 80 shows the NetWorker Administration Devices view. Some of the 
features shown in this view are as follows:

◆ Each read-write device in the list has a corresponding mirror, read-only device, 
which can be displayed in the Devices view, by toggling the View > Display 
read-only devices and volumes option. The devices are used together to enable 
concurrent read/write operations. 

◆ Each device is associated with a single NetWorker volume.

◆ Device status information and events are available only if SNMP is configured:

• Pre-Compression (/backup: pre-comp) indicates the amount of space that 
would have been used for backup if the data had not been deduplicated and 
compressed. The NetWorker software tracks this value as the size of backups.

• /backup: post-comp indicates three values, the total capacity of the Data 
Domain system, the amount of disk space actually used, and the amount of 
space available.
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• /ddvar indicates log file space used on the Data Domain filesystem.

• Compression (Reduction), which is represented by two values:

– Pre-Compression ÷ Post-comp Used
– (1 - Post-comp Used) ÷ Pre-Compression) x 100%

Figure 13 NetWorker Administration showing NetWorker Data Domain devices 

Monitor Data Domain backup statistics, log, and events
There are various ways to view NetWorker and data Domain backup statistics, logs, 
and events:

◆ To monitor Data Domain backup statistics:

In the NMC Enterprise window, select a Data Domain host. The right-hand panel 
shows the statistics for space on the selected system.

◆ To view statistics and log from the Data Domain monitoring page:

1. In the NetWorker Administration window Devices view, select Data Domain 
Systems.

2. Select a Data Domain system in the browser tree. 

The panels show the statistics and the backup log.
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◆ To view Data Domain events (SNMP traps):

1. In the NMC window, select the Events view.

2. In the NetWorker Administration window, select the Monitoring view. 

The Data Domain events appear in the Alerts table.

Backup, recovery, and clone reports
Statistical reports of NetWorker Data Domain backup, recovery, and clone activities 
are available from the NMC Reports view. 

Configure a report
To configure and display a Data Domain backup or clone report:

1. From the NetWorker Management Console window, click Reports.

2. Expand the Reports folder, expand the Data Domain Statistics folder, and then 
select a summary or statement report type to view.

The Configure tab for the selected report type appears in the right panel. 

3. In the Configure tab, customize the items that you want to include in the report 
by selecting the item parameters and clicking the Remove (‹), Add (›), Remove 
All («), or Add All (») buttons as required.

If Save Time values are not specified, the report will display all the available data.

Table 3 on page 81 lists details of report configuration parameters. The specific 
parameters available depend on the type of report selected.

Figure 14 on page 82 shows an example report configuration.

4. To display the report, select the View Report tab.

Table 3 Data Domain report configuration parameters 

Parameter Description Options

Server Name Selects managed hosts within the enterprise. Selected server names

Group Name Selects one or more groups. Selected group names

Client Name Selects one or more clients. Selected client names

Save Set Name Selects one or more save sets. Values are 
case-sensitive and wild cards cannot be used.

Selected save set names

Save Time Limits the report to a specified time range.

Note: The date/time format available depends on 
the language locale of the operating system. 

Save time (range)
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Figure 14 Report configuration

View a report
Backup reports are available in various formats. Most are basic reports. The Backup 
Summary and Monthly Client Statement are drill-down reports:

◆ “Basic reports” on page 82 describes details of basic reports.

◆ “Table 4 on page 83 describes the basic reports available for Data Domain.” on 
page 83 describes details of drill-down reports.

◆ “Advanced Reporting” on page 84 describes advanced reporting functionality 
with the optional EMC Data Protection Advisor (DPA).

◆ For clone operations, there is no specific report. You can query and list the copies 
of save sets in the NetWorker Administration, Media view, under Save Sets.

Basic reports
A basic report collects statistics for a specific datazone component, time span, or 
attribute. You can modify the scope of a report by adjusting the parameters on the 
Configure tab.
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Table 4 on page 83 describes the basic reports available for Data Domain.

Drill-down reports
A drill-down report consists of multiple basic reports, connected as layers and all 
configured with the same parameters used in the top layer.

Reports can be run for groups, clients, or save sets. You can modify the scope of a 
report by adjusting the parameters on the Configure tab.

Table 4 Data Domain basic reports 

Report name Purpose

Client Summary For all or specified clients, provides the following statistics:
• Amount of data: The amount of the data that would have been moved by using 

traditional NetWorker backup (protected data).
• Target size: Size of the data after deduplication has taken place on the Data 

Domain System (stored data).
• Deduplication ratio: Percentage of savings by using Data Domain 

deduplication.
• Number of Save Sets: The number of save sets included in the backup.
• Number of Files: The number of files included in the backup.

Save Set Summary For all or specified save sets, provides deduplication statistics on the following:
• Amount of data: The amount of the data that would have been moved by using 

traditional NetWorker backup.
• Target size: Size of the data after deduplication has taken place on the Data 

Domain System.
• Deduplication ratio: Percentage of savings by using deduplication.
• Number of Save Sets: The number of save sets included in the backup.
• Number of Files: The number of files included in the save set.

Save Set Details Displays details about each save set, including backup duration.
The Save Set Details report provides statistics on the following:
• Save Set ID
• Save time
• Backup level
• Save Set size (protected data size)
• Target size: Size of the data after deduplication has taken place on the Data 

Domain System (stored data size).
• Deduplication ratio: Percentage of savings by using deduplication.
• Number of Files: The number of files included in the save set.

Monthly Summary Displays statistics on a month-to-month basis.

Daily Summary Displays statistics on a day-to-day basis.
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Table 5 on page 84 lists the drill-down reports available for Data Domain Statistics.

Data Domain statistic reports
Use the Data Domain gstclreport command with a specified format to generate a 
specific Data Domain Statistics report.

The Data Domain product documentation provides details.

Advanced Reporting
NMC provides reports for only the recent backup history in a specific datazone. The 
optional EMC DPA software can provide extended reports of backups, trends, and 
analysis for one or multiple datazones, including reports of Data Domain systems. 
DPA is recommended for larger environments where additional analysis with 
forecasts and trends are required.

Troubleshooting
The following sections will help you identify and resolve common configuration and 
operation issues. 

Name resolution issues
If connectivity issues are present, ensure that the network names are valid and 
consistent for the NetWorker server, the storage nodes, and the Data Domain 
systems. Use the same names that are used within the NetWorker software 
configuration. 

Validate connections in both directions for both IP address and network names. If you 
use short names or aliases, then these should also be verified. Correct improper 
names by amending DNS entries or by populating the local hosts files:

◆ Use the NetWorker nslookup command to verify that network names resolve to 
the appropriate IP address on storage nodes and servers. 

◆ On the Data Domain system, you may use the net hosts command.

Table 5 Data Domain statistics drill-down report

Report name Purpose Sequence

Backup Summary Reports backup statistics over a period of time, 
starting from client summary down to individual 
save sets level.

1. Client Summary
2. Save Set Summary
3. Save Set Details

Monthly Client 
Statement

Reports backup statistics of individual clients 
on a month-to-month and day-to-day bases, 
down to individual save sets details.

1. Client Summary
2. Monthly Summary
3. Daily Summary
4. Save Set Details
EMC NetWorker and EMC Data Domain Deduplication Devices Release 7.6 Service Pack 2 and later Integration Guide84



Monitoring, Reporting, and Troubleshooting
Network connection issues 
The network connections for a Data Domain system can be tested by using the net 
lookup command through an SSH telnet session, which requires sysadmin or 
administrator permissions. The Data Domain system can also show the current 
network configuration by using the net show and other network related commands, 
available through the Data Domain interface (http://DDR_IP_ADDRESS). Log in 
and go to the specific Data Domain system. Then select the Hardware > Network tabs 
to access the commands.

Diagram and verify all relevant network connections. A typical Data Domain 
network configuration should provide a minimum of two network connections, one 
of which is dedicated to administration and the other for backup data only. Although 
this is not a firm requirement, it is strongly recommended as a best practice. Make 
effective use of 10 GbE connectivity or multiple backup connections that are 
aggregated or “teamed” by using the ifgroup command on the Data Domain system.

Device access errors
The following error messages can occur when NMC cannot connect to a NetWorker 
Data Domain device:

Volume unavailable error
If the Data Domain filesystem becomes inaccessible or has been disabled and 
re-enabled, for example for service or testing, the devices are left in an unmounted 
state and backup operations for the devices will elicit the following error message.

“Waiting for 1 writable volume(s) to backup pool.”

1. In the NetWorker Administration window, click the Devices view. 

2. In the Devices table, right-click and select Mount for any unmounted NetWorker 
Data Domain device.

3. In the Enabled column, ensure the device is enabled. If not enabled, right-click 
the device and select Enable/Disable.

NFS service errors
The NetWorker software requires the Data Domain NFS service to be enabled in 
order to access NetWorker Data Domain devices. If NFS is not enabled, an error such 
as the following results, typically while attempting to label a device:

◆ “Failed to contact the Data Domain system. Host could be unreachable, or 
username/password could be incorrect. Do you wish to configure manually?”

◆ “The user has insufficient privilege.”

“Configure the Data Domain system for NetWorker” on page 52 describes how to 
enable NFS access.
Troubleshooting 85



Monitoring, Reporting, and Troubleshooting
Backup fails for older NetWorker application modules
The Data Domain backup attribute in the Client resource is intended to ensure that 
only NetWorker Data Domain devices will be used for backups, even if the configured 
pool contains a mix of other device types, although pools with mixed devices are not 
recommended. 

NetWorker application modules support backup to NetWorker Data Domain devices, 
although the older modules do not support the Data Domain backup and Target 
Pool or Pool attributes in the Client resource and these attributes must not be set.

The EMC NetWorker Administration Guide provides details on how to configure a pool 
to target NetWorker Data Domain devices only.

The release notes for the specific NetWorker application modules provide details on 
supported Data Domain configurations.

Replace a failed or old storage node
If a storage node fails or is replaced with a new storage node, the data that is stored 
on the associated NetWorker Data Domain devices may be recovered on a different or 
replacement storage node. The success of the recovery depends on the state of the 
devices at the time of the loss:

◆ If the storage volumes were unmounted when the disruption occurred, the 
structure and integrity of the data should not be affected and a complete recovery 
can be expected. 

◆ If the volumes were mounted but not reading or writing data, complete recovery 
is still likely. 

◆ If the devices were reading or writing at the time of the disruption, then data loss 
or corruption are more likely to have occurred and complete recovery cannot be 
assured.

Provided the volume structure of the devices are intact, if you service the failed 
storage node, or if you replace it with a new storage node that uses the same name, 
then the NetWorker server should be able to continue its operations with the existing 
devices with minimal impact.

However, if the replacement storage node has a different name or if you use the 
NetWorker server directly instead of a storage node, then you need to remove the 
devices from the NetWorker application and then re-create them as follows:

1. Ensure the following requirements:

• The replacement storage node has access to the original Data Domain system.

• The Networker server software is the same version as the original.

• The NetWorker server has all the same indexes and media database entries as 
the original.

2. From NMC, run the NetWorker application, select the Devices view, and select 
Devices in the navigation tree. 

3. For each affected original remote (storage node-based) NetWorker Data Domain 
device, right-click the device, select Properties, and record the following 
information:
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• General tab:

– Name
– Device Access Information

• Operations tab:

– Volume Name 
– Volume Pool 

4. Remove the original NetWorker Data Domain devices from the NetWorker 
application. The device folders will continue to exist on the Data Domain system:

a. In the Devices view, Devices tree, right-click and unmount each affected 
device that is mounted. Mounted devices have a Volume Name. 

b. In the Media view, Media Pool tree, right-click each affected Media Pool 
(Volume Pool), select Properties, and on the Selection Criteria tab, remove 
each affected device from the Target Devices list. 

c. In the Devices view, Devices tree, right-click and delete each affected device.

5. Re-create the devices on the NetWorker application associated with a replacement 
storage node: 

a. In the Devices view, right-click the Data Domain systems tree and run the 
New Device Wizard.

b. Specify the Data Domain system and OST credentials to gain access the 
system.

c. On the Select Folders to use as Devices page, select the NetWorker Data 
Domain devices (device folders) that were associated with the failed storage 
node.

When you leave this page, a message box notifies you that the devices were 
previously associated with a different storage node. Confirm your selection. 

d. On the Configure Pool Information page, specify the media pool for the 
devices and unselect the Label and Mount option. The devices must be 
manually mounted on the new storage node later in this procedure.

IMPORTANT

Ensure the Label and Mount checkbox is not selected. If the volume is 
re-labeled all the data will be lost. This action cannot be undone. 

e. On the Select the Storage Nodes page, select a storage node to handle the new 
devices by doing one of the following:

– Select an existing storage node
– Create a replacement storage node
– Use the NetWorker server itself, which will handle the devices
The storage node must be running on the appropriate network and its 
hostname must be resolvable by DNS.

f. Complete the wizard.

6. Manually mount each new device:

a. From the NetWorker Administration window, click Devices.

b. Click View > Display read-only devices and volumes to unhide the 
associated read-only devices.
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c. In the navigation tree, select the Data Domain system.

d. In the right panel, right-click each device and each corresponding read-only 
(RO) device to be mounted, and select Mount.

The device mounts on the storage node and will use the label associated with the 
pool you have specified.

7. Review the NMC log for any error messages.

If no errors are reported from this procedure, then the device and its volume should 
be available for use. Backup and recovery operations may require further 
configuration depending on the original settings and the purpose of the device 
recovery.
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NetWorker Data Domain device changes and limitations
The following sections describe changes to NetWorker Data Domain (DD Boost) 
devices between NetWorker 7.6 SP1 and 7.6 SP2 and later software.

Data Domain storage folder structure changed
To improve performance, NetWorker 7.6 SP2 and later, when used with DD OS 4.9 
and later, creates NetWorker Data Domain devices as sub-folders under Data Domain 
storage units (SU), which are also known as “parent folders” or “shared SUs” on the 
connected Data Domain system. By default, the NMC Device Configuration Wizard 
names each SU folder after the short hostname of the NetWorker server that creates 
the devices. 

Previously, in the NetWorker 7.6 SP1 software, each SU was itself a NetWorker Data 
Domain device and there was no recommended limit on the number of these device 
SUs. 

In the 7.6 SP2 and later environment: 

◆ Avoid more than 14 active SU folders on a single Data Domain system. These SU 
folders can handle the NetWorker Data Domain devices for 14 NetWorker 
datazones. 

◆ There is no recommended limit to the number of NetWorker Data Domain device 
folders that may be created under an SU folder. However, increasing the number 
of devices can impact Data Domain performance and maintenance.

IMPORTANT

Data Domain 5.0 or later systems with more than 14 active storage unit folders for 
NetWorker Data Domain devices can suffer impaired performance and hang.

An exception where more storage units might be configured could be for service 
providers to allow quota enforcements, or for reporting on actual capacity used and 
deduplication ratios for each application group or end-customer. However, this 
practice should not be configured where it is not explicitly required.

Upgrading to the new folder structure
NetWorker Data Domain devices that were created as SU folders by NetWorker 
7.6 SP1 are not modified in any way by upgrade to 7.6 SP2 and remain available 
without any changes. These old devices appear in the NetWorker Administration 
program’s Devices view, but they do not appear in the NMC Device Configuration 
Wizard.

With DD OS 5.0 and later, it is recommended to use no more than 14 SU folders. 
However, an existing DD OS 4.9 system may already have more than 14 NetWorker 
Data Domain devices that were configured at the level of Data Domain SU folders. 

Note: Data Domain system with more than 99 NetWorker Data Domain SU folders will fail the 
upgrade process from DD OS 4.9 to 5.0 and later.
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This limitation of 14 or fewer Data Domain SUs may be accommodated by the 
following three options:

◆ Use NetWorker 7.6 SP2 and later to create new devices within new SU folders and 
leave the old (NetWorker 7.6 SP1) data on the old devices. The old devices may be 
reconfigured as read-only, or disabled.

“Deactivating a device” on page 66 provides details.

◆ Migrate the data from old (7.6 SP1) devices by configuring a new path for them 
on the Data Domain system. 

“Migrating a top-level device to a storage unit folder” on page 91 provides 
details.

◆ Create new devices with NetWorker 7.6 SP2 and move the data from the old 
(7.6 SP1) devices to the new devices by using NetWorker staging. After all the 
data has been staged and verified, delete the old device configurations.

The EMC NetWorker Administration Guide provides details on staging.

Migrating a top-level device to a storage unit folder
A limit of 14 active SUs (parent folders) is recommended on Data Domain 5.0 and 
later systems. NetWorker Data Domain devices that were previously created by 
NetWorker 7.6 SP1 at the top level (the level of a Data Domain SU) may be migrated 
to become sub-folders of new SU folders. The SU folders in a DD OS 5.0 environment 
are named after the short hostname of the NetWorker server. 

Migration should be performed before upgrade from NetWorker 7.6 SP1 to 7.6 SP2.

To migrate existing top-level device data to a new SU on a Data Domain system:

1. From a command prompt on the Data Domain System, ensure that the old and 
new SU roots are exported and available to the NetWorker storage node through 
NFS or CIFS as follows:

Note: On Data Domain OS 4.9 systems, all DD Boost devices use a common root under the 
/backup/ost directory. On Data Domain OS 5.0 systems, each DD Boost device has a 
separate root under the /data/col1 directory.

• For the NFS protocol:
nfs show clients
Path Client Options
/backup/ost myshortname (rw,no_root_squash,no_all_squash,insecure)
/data/col1 myshortname (rw,no_root_squash,no_all_squash,secure)

Table 6 Upgrade options

DD OS NetWorker 7.6 SP1 Other NetWorker versions

DD OS 4.8 Upgrade (optional) to DD OS 4.9 NetWorker 7.6 SP1 only

Upgrade to DD OS 4.9 then upgrade to NetWorker 7.6 SP2

DD OS 4.9 Upgrade to NetWorker 7.6 SP2 (except if DFA will be used) Requires NetWorker 7.6 SP2

Upgrade to DD OS 5.0 then upgrade to NetWorker 7.6 SP2

DD OS 5.0, 
5.1, 5.2

Not supported Requires a minimum of NetWorker 
7.6.3.4 (NetWorker 7.6 SP4 or 
NetWorker 8.0 recommended)
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A * in the Client column denotes that the SU root is exported to all clients.

• For the CIFS protocol:
cifs show share
--------------- share backup_ost ---------------
browsing: yes
clients: myshortname
enabled: yes
maxconn: 0
path: /backup/ost
writeable: yes
--------------- share data_col1 ---------------
browsing: yes
clients: myshortname
enabled: yes
maxconn: 0
path: /data/col1
writeable: yes

2. If the root exports are not present in the nfs show clients or cifs show clients 
output, create them with the appropriate command:

• For NFS and Data Domain OS 4.9:

nfs add /backup/ost *  

• For NFS and Data Domain OS 5.0:

nfs add /data/col1 * 

• For CIFS and Data Domain OS 4.9:

cifs share create sharename path /backup/ost clients *

• For CIFS and Data Domain OS 5.0:

cifs share create sharename path /data/col1 clients *

Where sharename is a user-defined sharename, such as backup_ost or data_col1.

3. Ensure that an SU, to which existing NetWorker Data Domain devices may 
migrate to and share, is configured on the Data Domain system.

• If NetWorker 7.6 SP2 or later is installed and the Device Configuration Wizard 
has already been used to create a NetWorker Data Domain device, then an SU 
named after the NetWorker server hostname should already exist on the Data 
Domain system. 

• If NetWorker 7.6 SP2 or later is not installed, then an SU may be created 
manually as follows:

a. Note the short hostname of the NetWorker server, for example view 
Properties > System Summary. Replace any special characters such as “.” 
with “_”. 

b. On the Data Domain system, create an SU named after this short hostname:

For Data Domain OS 4.9:
ost lsu create storage-unit-name

For Data Domain OS 5.x:
ddboost storage-unit create storage-unit-name

4. If the NetWorker storage node uses a UNIX operating system, create a new 
directory to serve as the Data Domain mount point (ddmount) as follows:

a. Create a new directory named ddmount.
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b. Mount the OST root to this new directory:

– On Data Domain OS 4.9:
mount dd_hostname:/backup/ost /ddmount

– For Data Domain OS 5.0
mount dd_hostname:/data/col1 /ddmount

c. Create a new directory on the mount point to represent the new Data Domain 
device that will be used with NetWorker 7.6 SP2:

mkdir /ddmount/shortname/nw_device_name

Where shortname is the short hostname of the NetWorker server and 
nw_device_name is the new DD Boost device that the NetWorker server will 
use.

For example: 
mkdir /ddmount/gidrathy/DZBurl_BACK_DD01

d. Change user:group ownership of this folder to be the same as the actual SU.

ls -l /ddmount/shortname
chown user:group /ddmount/shortname/nw_device_name

For example:
ls -l /ddmount/gidrathy
chown 501:100 /dmount/gidrathy/DZBurl_BACK_DD01

5. If the NetWorker storage node uses a Microsoft Windows operating system, map 
an available drive and create a NetWorker Data Domain device folder on the Data 
Domain system as follows:

a. Using Windows Explorer or a command line, map an available drive to the 
CIFS share folder on the Data Domain system (\\dd_hostname\sharename). For 
example:

net use Z: \\dd_hostname\sharename password /user:username

Where Z: is the available drive letter, dd_hostname is the hostname of the Data 
Domain system, and sharename is the CIFS sharename created on the Data 
Domain system such as backup_ost or data_col1.

Note: A username and password may be required to map this drive. Specify an account 
that has write access to the share folder, such as the sysadmin or the OST user account.

b. In Windows Explorer, expand the mapped drive and expand the SU (which is 
named after the short hostname of the NetWorker server). 

c. Create a new folder within the SU that will represent the new NetWorker Data 
Domain device to be used with NetWorker 7.6 SP2 and later. For example: 
DZBurl_BACK_DD01.

6. Move the data from the old SU path to the new SU path by using one of the 
following methods:

• On a UNIX storage node (or a Microsoft Windows system that is mounted to 
the Data Domain system):

mv /ddmount/pre762_nw_device_name/* /ddmount/shortname/
nw_device_name/

mv /ddmount/pre762_nw_device_name/.nsr /ddmount/shortname/
nw_device_name/
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• On a Microsoft Windows storage node:

Use Windows Explorer to move files from:

Z:\ddmount\pre762_nw_device_name 

to 

Z:\ddmount\shortname\nw_device_name

Where:

– pre762_nw_device_name is the name of the existing 7.6 SP1 Data Domain SU.
– shortname is the short hostname of the NetWorker server.
– nw_device_name is the name of the newly created NetWorker Data Domain 

device.
For example, move files from:
Z:\ddmount\My_Old_BACK_DD01

to 
z:\ddmount\gidrathy\DZBurl_BACK_DD01

7. Unmount the export from the NetWorker storage node:

• On a UNIX storage node:

umount /ddmount

• On a Microsoft Windows storage node:

In Windows Explorer, right-click the mapped drive and select Disconnect, or 
from a command prompt type:

net use Z: /delete

8. On the Data Domain system, remove the NFS or CIFS export that was created.

• For NFS and Data Domain OS 4.9:

nfs del  /backup/ost *

• For NFS and Data Domain OS 5.x:

nfs del /data/col1 * 

• For CIFS and Data Domain OS 4.9:

cifs destroy sharename

• For CIFS and Data Domain OS 5.0:

cifs destroy sharename

9. Delete the pre 7.6 SP2 SU on the Data Domain system, which is now empty:

• For Data Domain OS 4.9:

ost lsu delete pre762_nw_device_name

• For Data Domain OS 5.0:

ddboost storage-unit delete pre762_nw_device_name

10. Configure the device access information:

a. Connect to the NetWorker server using NMC and click the Devices view.

b. In the View menu, select Display Read Only Devices.

The Devices table displays both read-write and related read-only devices.

c. Click Devices in the navigation tree.

d. In the Devices table, right-click on the DD Boost device and select Properties.
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e. Update the Device Access Information field from the pre 7.6 SP2 device 
configuration to the new SU and Data Domain device configuration in the 
following format: 

dd_hostname:shortname/nw_device_name

Where:

– dd_hostname is the name of the Data Domain system.
– shortname is the short hostname of the Networker server.
– nw_device_name is the new DD Boost device name.

f. Click OK.

11. Enable the read-write and read-only devices:

a. Right-click the DD Boost device and select Enable/Disable.

b. Right-click the DD Boost device and select Mount.

c. Right-click the corresponding read only device and select Enable/Disable.

d. Right-click the corresponding read only device and select Mount.
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This glossary provides definitions for terms used in this guide.

A
administrator Person who normally installs, configures, and maintains software on network 

computers, and who adds users and defines user privileges.

advanced file type
device (AFTD)

Disk storage device that uses a volume manager to enable multiple concurrent 
backup and recovery operations and dynamically extend available disk space.

attribute Feature of a NetWorker resource. It is a setting or information that the resource 
provides.

B
backup 1. Duplicate of database or application data, or entire computer system, stored 

separately from the original, which can be used to recover the original if it is 
destroyed or damaged. 

2. Operation that saves data to a volume for use as a backup.

backup group See “group.” 

backup volume See “volume.” 

Boost An optimized library and communication layer with a special Data Domain API that 
allows NetWorker to interact with the Data Domain system.

bootstrap Save set that is essential for NetWorker disaster recovery procedures with the 
NetWorker server. The bootstrap consists of three components that reside on the 
NetWorker server: the media database, the resource database, and a server index.

browse policy NetWorker policy that specifies the period of time during which backup entries are 
retained in the client file index. The index makes the associated backed-up data 
readily accessible for recovery by desktop users. See “retention policy.” 

C
client Computer, workstation, or application server whose data can be backed up and 

restored with the NetWorker or NMDA software.
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client file index Database maintained by the NetWorker server that tracks every database object, file, 
or filesystem backed up. The NetWorker server maintains a single index file for each 
client computer. The tracking information is purged from the index after the browse 
time of each backup expires.

Client resource NetWorker server resource that identifies the save sets to be backed up on a client. 
The Client resource also specifies information about the backup, such as the schedule, 
browse policy, and retention policy for the save sets.

clone Duplicate copy of backed-up data, which is indexed and tracked by the NetWorker 
server. Single save sets or entire volumes can be cloned.

clone volume Exact duplicate of a backup or archive volume. NetWorker software can track four 
types of volumes (backup, archive, backup clone, and archive clone). Save sets of 
these different types may not be intermixed on one volume. Clone volumes may be 
used in exactly the same way as the original backup or archive volume.

clone-controlled
replication

Creation of a replica of deduplicated data copied from one NetWorker Data Domain 
device to another, which can be scheduled by the NMC clone feature and is indexed 
and tracked by the NetWorker server.

Console server See “NetWorker Management Console (NMC).” 

D
database 1. A collection of data arranged for ease and speed of update, search, and retrieval 

by computer software. 

2. An instance of a database management system (DBMS), which in a simple case 
might be a single file containing many records, each of which contains the same 
set of fields.

datazone Group of clients, storage devices, and storage nodes that are administered by a 
NetWorker server.

DD Boost An optimized library and communication framework with a special Data Domain 
API that allows the NetWorker software to define and interact with storage devices 
on the Data Domain system. 

DD Boost device See ”NetWorker Data Domain device.”

DD OS Data Domain Operating System.

deduplication Process used to compress redundant data.

deduplication
backup

Type of backup in which redundant data blocks are replaced by metadata pointers 
and only unique blocks of data are stored. When the deduplicated data is restored, 
the data is returned to its original native format.

deduplication ratio Reduction in storage space required to store data as a result of deduplication 
technology, usually combined with data compression, for example, a 20:1 space 
reduction.

device 1. Storage folder or storage unit that can contain a backup volume. A device can be a 
tape device, optical drive, autochanger, or disk connected to the server or storage 
node. 
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2. General term that refers to storage hardware. 

3. Access path to the physical drive, when dynamic drive sharing (DDS) is enabled.

disaster recovery Restore and recovery of business operations and data in the event of hardware failure 
or software corruption.

distributed segment
processing (DSP)

Part of the DD Boost interface that enables data deduplication to be performed on a 
host before the data is sent to the Data Domain system for storage.

E
enabler code Special code that activates the software. The enabler code that unlocks the base 

features for software is called a base enabler. Enabler codes for additional features or 
products (for example, library support) are called add-on enablers.

G
group Client computer or group of clients that are configured to back up files during a 

NetWorker scheduled backup, according to a single designated schedule or set of 
conditions.

H
host Computer on a network.

host ID Serial number that uniquely identifies a host computer.

hostname Name or address of  a physical or virtual host computer that is connected to a 
network.

L
label Electronic header on a volume used for identification by NetWorker or other data 

mover application.

license enabler See “enabler code.” 

M
managed application Program that can be monitored or administered, or both from the Console server.

media Physical storage, such as magnetic tape, optical disk, or filesystem, to which backup 
data is written. See also “volume.” 

media index Database that contains indexed entries of storage volume location and the lifecycle 
status of all data and volumes managed by the NetWorker server. Also known as 
media database.

media pool See “pool.” 

mtree A logical partition of the namespace in a Data Domain file system that can be used to 
group a set of files for managment purposes, shortened from “managed tree.” Mtrees 
may be used as storage units and be associated with NetWorker data zones.
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multiple session
backup and restore

Method of backing up or restoring multiple parallel streams of data simultaneously 
between a database and multiple media devices. Also known as multistripe.

multiplex To simultaneously write data from more than one save set to the same storage device.

N
NetWorker Data
Domain device

A logical storage device created on a Data Domain server, which is used to store 
deduplicated NetWorker backups. Each device appears as a folder on the Data 
Domain system and is listed with a storage volume name in NMC.

NetWorker
Management

Console (NMC)

Software program that is used to manage NetWorker servers and clients. The NMC 
server also provides reporting and monitoring capabilities for all NetWorker 
processes.

NetWorker server Computer on a network that runs the NetWorker server software, contains the online 
indexes, and provides backup and restore services to the clients and storage nodes on 
the same network.

notification Message sent to the NetWorker administrator about important NetWorker events.

O
online indexes Databases located on the NetWorker server that contain all the information 

pertaining to the client backups (client file index) and backup volumes (media 
database).

optimized clone See ”clone-controlled replication.”

P
pathname Set of instructions to the operating system for accessing a file. An absolute pathname 

indicates how to find a file starting from the root directory and working down the 
directory tree. A relative pathname indicates how to find a file starting from the 
current location.

policy Set of defined rules for client backups that can be named and applied to multiple 
groups. Groups have dataset, schedule, and retention policies. 

pool 1. NetWorker feature that assigns specific backup data to be stored on selected 
media volumes. 

2. Collection of NetWorker backup volumes to which specific data has been backed 
up.

R
recover To restore data files from a backup volume to a client disk and apply transactional 

(redo) logs to the data to make it consistent with a given point in time.

remote device 1. Storage device that is attached to a storage node that is separate from the 
NetWorker server. 

2. Storage device located at an offsite location that stores a copy of data from a 
primary storage device for disaster recovery.

replication Process of creating an exact copy of an object or data. 
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resource Software component that describes details of the NetWorker server or its clients. 
Clients, devices, schedules, groups, and policies are all NetWorker resources. Each 
resource has configurable attributes that define its properties.

resource database NetWorker database of information about each configured resource.

restore To retrieve individual data files from backup media and copy the files to disk, 
without applying transaction logs. See also “recover.” 

retention policy NetWorker setting that determines the minimum period of time that backup data is 
retained on a volume available for recovery. After this time is exceeded, the data is 
eligible to be overwritten. See also “browse policy.” 

retrieve To locate and recover archived files and directories.

S
save NetWorker command that backs up client files to backup media volumes and makes 

data entries in the online index. 

save set Group of files or a filesystem that has been backed up on storage media by using the 
NetWorker software.

save set ID (ssid) Internal identification number assigned to a save set.

save stream Data and save set information that is written to a storage volume during a backup. A 
save stream originates from a single save set.

scheduled backup Type of backup that is configured to start automatically at a specified time for a group 
of one or more NetWorker clients. A scheduled backup generates a bootstrap save set.

ssid See “save set ID (ssid).” 

storage device See “device.” 

storage node Storage device physically attached to a computer other than the NetWorker server, 
whose backup operations are administered from the controlling NetWorker server.

storage unit (SU) Logical unit of disk storage on a Data Domain system that is associated with a 
NetWorker datazone.

T
trap Setting in an SNMP event management program to report an error or status message.

V
virtual tape library

(VTL)
Software emulation of a physical tape library storage system.

volume 1. Unit of physical storage medium, such as a magnetic tape, optical disk, or 
filesystem used to store data. Backup data must be stored on a backup volume 
and cannot be stored on an archive volume or a clone volume. 

2. Identifiable unit of data storage that may reside on one or more computer disks. 

volume ID (volid) Internal identification that NetWorker software assigns to a backup volume.
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volume name Name that you assign to a backup volume when it is labeled. See also “label.” 
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EMC NetWorker and EMC Data Domain Deduplication Devices Release 7.6 Service Pack 2 and later Integration Guide104



E

Index
storage node  26
storage space, cleaning  27
storage unit  24
storage units

number of  24
storage units, creating  53

T
target devices  62
target sessions  25, 59
throughput, maximize  30
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